
Introduction

The desire to take medicine is perhaps the greatest feature which distinguishes man from animals.
Sir William Osler

Hypertension, the medical name for high blood pressure, is a common chronic medical 
problem in the United States responsible for a major portion of cardiovascular disease.

The success in the control of hypertension is generally credited to a combination of 
improved detection and the use of antihypertensive medication. However, the implications 
of long-term drug therapy for millions of Americans are unknown. There are documented 
side effects of the antihypertensive drugs. Thiazide diuretics, for example, can induce short-
term increases in serum cholesterol, low density lipoproteins (LDL), and triglyceride levels in 
some people. These and other risks of drug therapy call attention to the potential benefits of
nonpharmaceutical treatment of high blood pressure.

Currently, three non drug methods--weight control, alcohol restriction, and sodium 
restriction--are recommended as part of the treatment for established hypertension. These 
measures have also gained support as likely to aid in the prevention of high blood pressure, 
particularly for those at high risk.

Historical perspective

The first successful dietary treatment of human hypertension has been attributed to 
Kempner's rice-fruit diet that provided 20 g of protein, less than 5 g of fat, 150 mg of 
sodium, 200 mg of chloride, and 3,000 mg of potassium per day. Other studies confirmed 
that a very low sodium intake, for example, 200 mg/day, was effective in lowering blood 
pressure.

The positive association between body weight and blood pressure was documented more 
than 60 years ago. Clinical treatment of hypertension with weight reduction was reported 
over 60 years ago by Rose, who documented lower blood pressure and relief of edema in 
obese patients who lost weight.

The role of dietary salt in hypertension was a major issue at the White House Conference on 
Food, Nutrition and Health and at the Senate Select Committee hearings in 1969. 
Subsequently, a committee of the National Academy of Sciences recommended that no 
more than 0.25 percent salt be added to the commercial preparation of infant food.

Appropriate caloric intake to maintain desirable weight and avoidance of excessive sodium 
intake are goals included in the Surgeon General's Report on Health Promotion and Disease 
Prevention.

Significance for Public Health

In the United States, hypertension is a public health problem of enormous magnitude. 
Almost 58 million individuals have been found to have elevated blood pressure or have 
reported taking antihypertensive drugs prescribed by a physician.

Hypertension is a major risk factor both for heart disease, which is the leading category of 
causes of death in the United States, and for stroke, which is the third most frequent cause 
of death. A high proportion of end-stage renal failure is due to hypertension.



Role of Obesity in Hypertension

Increase in body weight is related to increased blood pressure. Furthermore, a fall in blood 
pressure can be expected with weight reduction.
Weight loss is recommended for all overweight persons, particularly for those with 
hypertension. It has been suggested that control of obesity would eliminate hypertension in 
48 percent of whites and 28 percent of blacks. Even when weight loss does not reduce blood
pressure to normal, health risks may be reduced, and smaller doses of antihypertensive 
medication may be needed as a result.

Role of Sodium in Hypertension

A relationship of sodium to hypertension is supported by several lines of evidence. In non-
Western populations with low salt consumption, blood pressure does not rise with age. 
Populations with low blood pressure generally do not consume much salt. These associations
have been reported among numerous populations such as the Bushmen of Kalahari, Indian 
tribes in Brazil, and other groups in New Guinea, Malaysia, the Polynesian Islands, and 
Solomon Islands.

Many clinical studies have examined the effect of moderate restriction of sodium 
consumption on blood pressure in adults. Long-term studies have shown that 39 percent of 
hypertensive patients could control blood pressure with sodium intakes below 50 mEq/day 
and close supervision by a dietician and physician, and about one-third of patients with mild 
hypertension could control blood pressure with a sodium intake of 75 mEq/day or less.

Role of Alcohol in Hypertension

Epidemiologic studies have shown that individuals who regularly consume large amounts of 
alcohol have higher blood pressure than people who abstain from alcohol or who drink only 
moderate amounts.

Role of Potassium in Hypertension

Potassium intake has been shown to correlate more strongly than any other 
dietary factor to blood pressure.
One of the earliest observations of the association of dietary potassium with reduced blood 
pressure concluded that "potassium salt regularly produced a decline in blood pressure, 
while sodium salt just as regularly produced as rise." It was later observed that potassium 
lowered blood pressure in individuals with hypertension even when the dietary salt intake 
remained high. The minimum RDA for potassium is approximately 1,600 to 2,000 mg per 
day. However, since there is considerable evidence that dietary potassium exerts a 
beneficial effect in hypertension, the National Research Council recommends that intake of 
fruits and vegetables be increased to raise potassium intake of adults to about 3,500 mg a 
day.

See also The K Factor

Role of Calcium in Hypertension

An association between calcium and blood pressure was suggested by reports that 'hard' 



drinking water (containing calcium) was associated with reduced prevalence of 
cardiovascular disease. This association between calcium and blood pressure is supported 
by observations from the Puerto Rico Heart Health Program that individuals who drank no 
milk (which is high in calcium) had twice the prevalence of hypertension as those who 
consumed a quart of milk or more per day.

An analysis of the National Health and Nutritional Examination Survey I data found an 
inverse, although inconsistent, association between dietary calcium and blood pressure; the 
lower blood pressures were correlated with higher levels of serum calcium.

Role of Omega-3 Fatty Acids

The role of omega-3 fatty acids in blood pressure lowering has received considerable 
attention. Investigators have reported that the ingestion of enough fish to provide 5g of 
omega-3 fatty acids per day for 2 weeks caused a significant fall in blood pressure, and the 
lower blood pressure could be maintained subsequently by the weekly consumption of 20 oz
of fish that provided 1.2g/day of omega-3 fatty acids. [ The registered version of this 
software package contains another Windows program: Omega-3 Counter. This program 
has a database of foods with highest concentration of omega-3. ]

NutriGenie Lower High Blood Pressure is an indispensable tool to those with high blood 
pressure to monitor their diet and to control their weight. The program is based on the 
report of the Joint National Committee on Detection, Evaluation, and Treatment of High Blood
Pressure and on the U.S. Surgeon General's dietary guidance for hypertensive patients. It is 
an excellent complement to any nondrug approach to treatment for and prevention of high 
blood pressure.

See also Obesity



About Lower High Blood Pressure

NutriGenie Lower High Blood Pressure lets health professionals (physicians, dieticians, 
etc.) quickly and accurately prescribe optimal diet to their hypertensive patients. The 
program can also be used by patients themselves to monitor the amount of fat, cholesterol, 
sodium, carbohydrate, potassium, fiber, calcium, protein and calories in their diet. The 
program helps users become more informed and make better nutritional choices to control 
hypertension; however, it is not intended to replace professional advice from user's 
physician. Please always obtain your doctor's approval before adopting any diet or exercise 
program.

The registered version of NutriGenie Lower High Blood Pressure comes with a database of 
approximately 8,000 carefully selected food items divided into convenient food groups. 
Users can also add in their own food items via a separate user's food database.

Besides the sophisticated and unique tools to help users with meal planning such as our 
automatic menu generator using the ADA Food Exchange System and the USDA Food Guide 
Pyramid, the program provides utilities to calculate user's ideal weight, suggested daily 
caloric and other nutrient intakes according to his or her personal factors. There are also 
utilities to calculate body mass index, caloric expenditure, as well as a weight planner and 
cholesterol profiler. Users can also keep track of their blood pressure measurements, as well 
as their weight loss progress, diet history, etc.

To help users identify foods with high omega-3 concentration, an Omega-3 Counter 
program is also included in this package. Omega-3 fatty acids have been shown, in several 
studies, to help fight atherosclerosis and lower blood cholesterol levels.

Please note: Depending on where you obtain NutriGenie Lower High Blood Pressure, the 
Omega-3 Counter program may or may not be included in the evaluation version of this 
package [to reduce the download time from online services and to allow shareware 
distributors to fit Lower High Blood Pressure on one double-density diskette]. If not included, 
this program can be downloaded separately for evaluation; please look for file 
nsomega3.zip.



General Dietary Guidelines

Essential nutrients must be obtained from diet in proper amounts and proportions to 
maintain good health and to prevent deficiency diseases. A deficiency of an essential 
nutrient causes signs and symptoms that can be prevented or cured by an increased intake 
of the nutrient.
Just as a deficiency of a nutrient can cause disease, too much of a nutrient can also lead to 
disease. For example, the excessive consumption of energy, fat (especially saturated fat), 
and alcohol have been associated with the development of specific chronic disease 
conditions. Excessive intake of some vitamins and most of the minerals also has been shown
to result in either acute or long-term disorders.

For most nutrients, there is a safe and adequate range of dietary intake that satisfies 
nutritional requirements but does not cause undesirable symptoms. The need to establish 
goals for good nutrition in the United States led to the establishment of the Committee on 
Food and Nutrition, now called the Food and Nutrition Board of the National Research 
Council, National Academy of Sciences. The Board has established Recommended Dietary 
Allowances (RDAs) for energy, and other essential nutrients to sustain normal growth, 
development and health. For specific RDA data, please refer to the Caloric and Nutrient Requirement 
Dialog.

See also
Dietary guidelines for lowering high blood pressure
Dietary guidelines for diabetes
Dietary guidelines for lowering your cholesterol
Dietary guidelines for weight control



Disclaimer

The data and nutritional guidelines contained in this program are derived from research published by US 
government agencies and by private non-profit health organizations. The data and guidelines are 
compiled for your information only and must not be construed as medical advice or instruction. The 
decision concerning diet or medications should be made by you and your doctor. Before adopting any diet
or exercise program, please discuss your condition with your doctor and obtain his/her approval. 
NutriGenie disclaims all liability in connection with the use of this program.



New Features

Below is a list of new features which are common to all NutriGenie products. Specific new features which 
are applicable to a particular program are not listed.

New features with version 4.4 or later:

1. The Food Exchange System developed by the American Dietetic Association and the American 
Diabetes Association is implemented. This feature allows automatic menu generation based on user's
exchange specification and food selection. This feature may replace the personal food groups feature
in some programs.

New features with version 4.3 or later:

1. NutriGenie foods can be hidden and unhidden to make browsing the standard food database more 
convenient. 

2. Up to 7 personal food groups can now be created making it much easier to access your favorite 
foods.

New features with version 4.2 or later:

1. Products previously required SVGA display mode can now run on VGA. To accommodate the smaller 
screen display, the user specifies up to 10 nutrients for analysis in VGA mode. 

2. Adding foods and recipes to personal food database is now more convenient. The dialog box for this 
feature automatically copies nutrient data from meal, making minor editing quite easy. The personal 
food database format is retained and is compatible with exported text files from standard database 
software.

New features with version 4.1 or later:

1. After generating a daily meal plan, NutriGenie automatically displays the Pyramid Food Guide 
analysis for user's evaluation of the plan just generated.

New features with version 4.0 or later:

1. NutriGenie technology is implemented in all programs. With this technology, user can specify a daily 
caloric consumption level and NutriGenie will automatically generate well-balanced daily menus that 
meet this requirement.

2. unique graphic USDA Pyramid Food Guide Analysis is available in all programs.
3. selective printing of analysis data: when the number of nutrients analyzed is large, user can select the

nutrients to be printed.

New features with version 3.6 or later:

1. enhanced Body Mass Index dialog box
2. enhanced Caloric Need utility
3. Mouse Button Option dialog box
4. better automatic printer font support

New features with version 3.5 or later:

1. weight tracker utility allows you to maintain a graphic history of your weight loss progress.
2. diet tracker utility lets you keep track of your diet over time.
3. target heart rate calculator helps you get the most benefit from your exercise.



New features with version 3.2 or later:

1. percentages of calories from fat, protein and carbohydrate are now graphically displayed in addition to
the nutrients' weights. Each full section of the bar represents 10%. When the percentage of calories 
from fat exceeds the user specified value, the bar is displayed in white instead of dark gray.

2. toggling left mouse button quick input mode: you can now turn this feature on/off as desired.

3. right mouse button quick input mode has common serving sizes as option in addition to gram and 
ounce.

New features with version 3.0 or later:

1. most programs come with a professional food database containing approximately 10,000 food items 
(registered version); some programs still use a standard food database of approximately 1,000 most 
commonly used foods. Please carefully evaluate this difference before ordering.

2. more sophisticated food search capability: 'not' and 'and' Boolean search; global and local search

3. quick serving amount data entry

4. quick find: locate food consumed that is highest or lowest in a particular nutrient.

5. copy, cut and paste meals: editing food data is easier and easier because you can conveniently reuse
previously edited meals.

New features with version 2.x or later:

1. user's food database support,

2. printer font selection

3. screen color selection,

4. graphic analysis of nutrients,

5. RDA analysis,

6. context sensitive help,

7. set fat warning level

8. sorting based on nutrient contents, etc.

All previously available features are retained or improved.

Every NutriGenie product has been tested and is fully compatible with Windows 95, Windows NT as well 
as Windows 3.x.



About NutriGenie food databases

Depending on the availability of the required nutrient data, NutriGenie uses different food databases in 
our programs.

The registered food database of all NutriGenie programs version 4.0 or later contains an 8,000-
entry food database.

1. NutriGenie The Magical Dietitian 4.2
2. NutriGenie Fat to Fit 4.1
3. NutriGenie Pregnancy Nutrition 4.1
4. NutriGenie Calorie Counter 4.1
5. NutriGenie Fat Counter 4.1
6. NutriGenie Fat Cholesterol and Sodium Counter 4.1
7. NutriGenie Renal Diet 4.1
8. NutriGenie Immune Deficiency Nutrition 4.2
9. NutriGenie American Heart Diet 4.3
10. NutriGenie Diabetes Meal Planner 4.4
11. NutriGenie Lower High Blood Pressure 4.4

The registered food database of the following programs contains approximately 1,000 most 
commonly used food items. (See also Special Offer)
1. Fat and Cholesterol Counter 1.1
2. Control Diabetes 1.2
3. Pregnancy Nutrition 2.1
4. Pyramid Weight Loss Diet 3.4
5. Healthy Heart Nutrition 3.5

If you need a larger food database, please consider registering for any of the following programs 
which have a 10,000-entry food database (See also Special Offer):
1. Reduce Cancer Risk 3.0
2. Weight Perfect 3.0
3. Lower Your Cholesterol 3.2
4. High Blood Pressure Nutrition 3.2
5. Diabetic Nutrition 3.3
6. Nutrition for Women 3.5
7. Eat Well, Weigh Less 3.5
8. Nutrition for Peak Performance 3.6
9. The Compleat Nutritionist 3.6
10. Managing Diabetes 3.6

The German versions of our software below use a database of approximately 1,000 items. 
However, all of our food databases are frequently updated or enlarged. We will send you the latest
available programs and data.
- Ernährung für Frauen
- Das optimale Gewicht

Abbreviations:
To conserve space and to make the display of food names less cluttered, we have adopted a few 
abbreviations.

NFS not further specified
ckd cooked
ckg cooking
incl include / including
excl exclude / excluding



w/ with
w/o without

Note: 
Food items containing a general or nonspecific description, for example, "Beef, not further specified" have
been assigned nutrient values for a commonly eaten form of the food or for a composite of several forms. 
Values for most items containing two or more ingredients were calculated from ingredient data using 
representative recipes.

Nutrient values associated with specific brand named products were supplied by the companies in most 
cases. When not supplied by companies, values were estimated. Estimates are based on product 
ingredient lists, or on values for similar products.

Mention of commercial products in this database is solely for identification purposes and does not 
constitute endorsement over other products not mentioned.

See also User Food Database.



Main Uses of the Program

This NutriGenie program can do many useful things for you:

At the simplest level, it can determine your ideal weight and recommend the most healthful levels of 
nutrient and caloric intake to you. You can browse through the extensive food database and select the 
foods that provide the nutrients you need and avoid those that have too much fat, for example. You can 
view and print graphic analyses of your diet. These analyses can help you spot the nutritional 
weaknesses in your diet so you can improve it to enhance your health.

However, some of the more important uses of this NutriGenie program are 
· to analyze your current diet for conformance with specific guidelines,
· to automatically generate menus that satisfy your dietary requirements,
· to establish a weight control plan, etc.

A typical scenario for the first use:    you record the foods you eat at each meal during the day, then print 
out the analysis to see if your current diet is too high in fat, deficient in carbohydrate, etc.    You can also 
determine if your caloric intake is spread out rather evenly throughout the day or heavily concentrated at a
particular meal. [Some weight control plans recommend that the caloric intake is spread out evenly 
throughout the day.] Using the caloric analysis dialog box, you can also determine if too many calories in 
your diet come from protein or fat and modify your diet accordingly. Make sure you print out a hard copy 
of the analysis for a comprehensive view of your day diet. Each day's food consumption can be saved for 
future use. You can save the files as Mon, Tue, Wed or 0925 (for September 25th) or day1, day2, etc., the
program will automatically add in the file extension. Use whatever file names that you can easily 
remember. A convenient scheme is to name your files according to their caloric contents. For example, 
1200a, 1200b, 1800a, 1800b, etc. When you need a low-calorie diet, you can easily select the appropriate
files for consideration.

To establish a diet plan to lose or gain weight, you prepare the menu for each day by recording the foods 
you are going to eat for each meal or you can tell NutriGenie to generate these menus for you. For 
simplicity, let's assume you are going to repeat the menu cycle every week. In this case, you will prepare 
7 files (naming them Sun, Mon, Tue, Wed, Thu, Fri and Sat). Once these files are saved, you bring up the 
Weight Control Plan dialog box. The files should show up in the right list box. You then add all 7 files to 
your plan. After adjusting your weight and activity level, you will have an accurate picture of how much 
weight you will gain or lose when you follow this plan of diet. You can go back and adjust the food data in 
the files if you find that you are eating more or less than what is required to achieve your weight goal.

See also 
How to Use NutriGenie Technology in Weight Reduction Planning
How to Use the USDA Pyramid Food Guide to Evaluate Your Diet
How to Use the ADA Food Exchange System

Note: Before adopting any diet or exercise program, please obtain approval from your doctor.



RDA Analysis

The RDA figures are for the average normal and healthy people in the United States under usual 
environment stresses. Your optimal personal requirements may be different. In addition, diets should 
be based on a variety of common foods to provide other nutrients for which human requirements have 
been less well defined.

The RDA analysis is color coded as follows:

- yellow : below RDA i.e., too little
- green : within RDA i.e., just about right ( 91 - 130 % )
- magenta : above RDA i.e., more than enough
- red : well-above RDA i.e., much more than needed

In general, you should strive to achieve a balanced diet which is reflected by the green bars the analysis 
displays. Excessive consumption of certain nutrients is not desirable.

You can set your own preferred nutrient intake levels and the analysis colors are modified 
accordingly: a yellow bar is displayed when the current intake is below your desired range; green 
when within range; magenta when moderately above range and red when much higher than your 
preferred range.
Please note that the personal preferred nutrient intake specifications affect only the color of the analysis 
bars. The RDA percentage values are always based on the standard Recommended Dietary Allowances 
for a healthy person in your category (age, weight, life style).

Strictly speaking, there is no RDA for carbohydrates. However, the Food and Nutrition Board of the 
National Academy of Sciences recommends that more than half the energy requirement beyond infancy 
be provided by carbohydrates. 



The Main NutriGenie Window

This window is where you prepare your menus for each meal of the day. Our software follows the Multiple
Document Interface convention so you can have several windows open at the same time and you can 
copy meal from one window then paste it to another just like copying and pasting text.

There are several ways to prepare your menus. You can have the meals generated automatically by 
NutriGenie using the food exchange options or the calorie value you specify. Or you can prepare the 
menus manually.

Select a meal
To modify a daily food consumption document, you first select a meal you want to record the data for. 
There are 6 meals in a day: Breakfast, Morning Snack, Lunch, Afternoon Snack, Dinner and Evening 
Snack. Select one from the left pull-down list box. 

Then you select a food group from the right hand side pull-down list box. ( Depending on the program's 
database, there are approximately 30 to 50 food groups.) It is easy to get to the food group you want: 
once the input focus is at the food group combo box (by tabbing to or clicking the mouse on this control), 
you can type just the first letter of the food group and the next group name starting with that letter will be 
displayed. Repeating a character will cycle all the group names with that starting character through the 
combo box.

Browse food databases
The program lists foods in a food group by default. You can display food group names in normal order or 
reverse this order. 

displays food group names in normal order.

displays food group names in reverse order.

You can list foods in your personal food database:

 [ See also use your own    food database.]

Or you can search for foods by their names:

 [ See also Search mode.]

Select a food item
Highlight a food item in the right listbox, click on the 'I Eat' button. This item will be recorded in the meal 
you selected. You can also just double-click the food item without using the 'I Eat' button.

Sort foods by nutrient content
Starting with version 2.3 of our software, you can sort the food list on any individual nutrient. Select either 
the 

 ascending or 

 descending order. 
A floating menu will appear inside the listbox, you can then select the nutrient you would like to sort on. 
Once the list box is sorted, you can single click on a food item to review its nutrient's content. Please note
that from version 3.0, the nutrient contents sorted on are normalized to be based on each 100g of food 



item; this makes direct comparison between food items easier. A sort is valid only for the current content 
of the list box, this means if you move to another food group or do another food search, the new content 
will be listed in alphabetical order (except for the search content). When the list box is sorted, a small 
square appears inside a sort icon to indicate which sort sequence is in effect.

Specify the food amount
If necessary, you can adjust the amount consumed for this food item by typing the desired amount in the 
edit control above the 'Am(oun)t. OK' button. Once the right amount has been typed in, click on 'Amt. OK' 
to confirm and record this value. You need to use this button only when you manually enter the weight in 
the edit control. (Hint: Click left or right mouse button on the window's background to select a standard 
food amount for fast adjustment of quantity. You don't need to click on 'Amt. OK' when the portion is 
selected this way.)

Remove food from meal
If a food item is not what you intended to add to a meal, you can highlight it and then click on the 'Delete' 
button to remove it from your meal.

You can display the graphic caloric analysis of a food item in a meal by selecting an entry in your meal 
food consumption then click on the graph icon. A graph will appear to show you the percentages of 
calories of this food item that come from fat, protein and carbohydrate. To review the caloric analysis of 
your day food consumption, select the 'Caloric analysis...' menu item from the 'View' menu.

Repeat the food selection process for each meal, omitting the meals where you don't eat any food.

Save your menus
When you are done, you can save the day food consumption data for later review or for use in your 
weight control planning. Use 'File' 'Save As...' or the diskette button on the toolbar.

Hint:
- You can use 'Copy Meal' and 'Paste Meal' buttons on the toolbar for fast entry of food data when the 
same foods are eaten at different meals.
- Use 'Find Max' and 'Find Min' buttons to quicky identify foods eaten that are high in fat or low in 
carbohydrate, etc.

See also the Analysis Panel



The Analysis Panel

The analysis panel is the gray panel in the lower half of your screen. The panel is divided into 6 sections:

1. the Information section contains the names of the nutrients being analyzed and the weight or serving 
size of a food item.

2. the Food Item, Meal Total, and Day Total sections contain the numerical values of the contents of 
various nutrients in the food item, in a meal, and daily diet, respectively. They also show the caloric 
percentages from protein, carbohydrate and fat in bar graph format. Each full fraction of a bar 
represent 10% of caloric contribution from the nutrient. When the percentage of calories from fat 
exceeds that of user's specified value, the bar color is displayed in white instead of dark gray.

3. the %RDA section shows the percentage of Recommended Dietary Allowances for your daily diet 
both numerically and graphically. The color of the bar graph correspond to user's own personal 
Nutrient Intake Preference.

4. the Unit section lists the unit of measurement for each analyzed nutrient.



Edit meals

If you would like to reuse a meal (or repeat a few food items) in your diet, here is a convenient way to do 
so: prepare the meal (or the food items) you plan to reuse. Copy or cut it to the clipboard; then go to 
another meal or open another day's file and paste to a new meal! The serving information is retained, not 
just the food name. When you insert a meal into a partially planned meal, the inserted food items will 
appear immediately below the currently selected food item in the receiving meal.
You can also delete all food items from a meal by using the Edit Clear All command or the Clear All icon.



Food Groups Mode

In this mode, the default mode, you will see a pull down listbox that contains approximately 50 food 
groups such as "Cookies", "Oils", "Beef", etc. By selecting any of these food groups, the food items 
belong to the group will be displayed in the list box immediately below. This mode is useful when you 
want to browse through the standard database, or when you want to do your menu planning which 
requires selection of foods from different food groups.

Since there are about 50 food groups and the average screen can display only 30 or so food groups at a 
time in a drop down list box, there are 2 icons to facilitate your viewing of the food groups. By alternating 
between these 2 icons, you can see the complete list of food groups in the drop down list box. You can 
also select a food group by typing the first character of its name when this list box has the focus.

displays food groups in normal order in drop down list box.

displays food groups in reverse order in drop down list box.



Food groups

The food groups in the NutriGenie 8,000-entry database are:

1. Milk, Yogurt, Cream, Milk Drink
2. Ice cream, Cheese, Pudding, Milk products
3. Eggs, Egg products
4. Beef
5. Pork, Ham, Bacon
6. Lamb, Veal, Game
7. Poultry
8. Liver, Organ meats
9. Sausages, Lunch meats, Hot Dog
10. Fish, Shellfish
11. Sandwiches, Burger, Pizza
12. Mixed dishes with meat
13. Mixed dishes with vegetable
14. Mixed dishes with grain products
15. Soups
16. Breads, Rolls, Flour
17. Cakes
18. Pies, Pastries
19. Cookies, Crackers, Other grain products
20. Cooked Cereals, Rice, Pasta
21. Cereals not cooked
22. Fruits, Citrus, Juices
23. Legumes, Nuts, Seeds
24. Vegetables
25. Potatoes
26. Pickles, Relishes, Olives
27. Fats, Oils, Salad dressing
28. Sugars, Sweets
29. Beverages, non-alcoholic
30. Beverages, alcoholic

The food groups in the 10,000-entry database are:

1. MILK, Milk Drinks
2. CREAM, Cream Substitutes
3. MILK DESSERTS, SAUCES, GRAVIES
4. CHEESES
5. BEEF
6. PORK
7. LAMB, VEAL, GAME
8. POULTRY
9. ORGAN MEATS
10. SAUSAGES, LUNCH MEATS
11. FISH, SHELLFISH
12. MIXED DISHES w/ sauce
13. MIXED DISHES w/ starch
14. MIXED DISHES w/ starch and vegetables
15. MIXED DISHES w/ vegetables
16. SANDWICHES
17. FROZEN MEALS, w/ meat, poultry, fish base
18. EGGS, EGG PRODUCTS



19. LEGUMES
20. NUTS, SEEDS
21. BREADS (yeast), ROLLS, FLOUR
22. BREADS, QUICK
23. CAKES
24. COOKIES
25. PIES, PASTRIES
26. CRACKERS, SNACKS from grain products
27. PANCAKES, other grain products
28. PASTAS, COOKED CEREALS, RICE
29. CEREALS not cooked or NS
30. GRAIN MIXTURES DISHES
31. GRAIN MIXTURES, Frozen Meals
32. GRAIN MIXTURES, Soups
33. FRUITS, citrus, juices
34. FRUITS, dried
35. FRUITS, other
36. FRUIT JUICES, Nectars (non-citrus)
37. VEGETABLES, starchy
38. VEGETABLES, dark green
39. VEGETABLES, deep yellow
40. TOMATOES, tomato mixtures
41. VEGETABLES, other, raw
42. VEGETABLES, other, cooked
43. PICKLES, RELISHES, OLIVES
44. VEGETABLE SOUPS
45. VEGETABLES w/ meat, poultry, fish
46. FATS
47. OILS
48. SALAD DRESSINGS
49. SUGARS, SWEETS
50. BEVERAGES, non-alcoholic
51. BEVERAGES, alcoholic



Search mode

This is one of the most convenient features of NutriGenie programs. It allows you to find any particular 
food items from the standard and user databases without your having to browse through different 
categories of food groups.

Search mode

When this mode is selected, an edit control is displayed in place of the Food Group combo box and 2 
search icons are shown. You type in the name of the food item you want to find, for example "apple", then
click on one of the search icons. The list box will be filled with all food items containing "apple". You don't 
need to type in a complete word: "app" will suffice. On the other hand, when there are too many matching 
food items, you might want to restrict the match by specifying longer name such as "apple juice" or do a 
local search after having the result of the global search. The search is not case sensitive: you can use 
lower or upper case letters and this won't affect the result.

To exclude food items, use ! (the exclamation point) before the text string. Search on !spinach will 
display all items that do not have 'spinach' in their names.

The program will look for matching entries not only in the standard food database that comes with your 
software but also in your own personal food database.

The matched food items displayed in the list box can be selected as those in any other mode.

In the registered version of the software, there is no restriction on the size of the user database on which 
the search will be performed. However, memory limitation of your system might prevent the display of all 
matched entries in the list box. In this case, a message box will appear to alert you of this situation.

In the shareware version, search will be performed on the abbreviated standard database and on the first 
several records of the user database.

Global search: searches both the NutriGenie and user databases for a food item containing or not 
containing a text string. On a 486-33 system, a global search takes just under 5 seconds.

Local search: searches only the listbox's content for food items containing or not containing a text string. 
This is convenient for pruning down a previous search result which might contains hundreds of food 
items.

Tip: 
After entering the text to be searched, you can use Alt-G to do a global search or Alt-L to do a local 
search without having to use the mouse to click on a search icon.



Personal Food Database

Occasionally you may not find a food item in the standard database. What do you do when you've just 
eaten a serving of Haagen-Dazs ice cream? Or want to include a favorite ethnic TV dinner in your weekly 
plan? Most of these items do have nutritional information on their packaging. NutriGenie program can 
access and use their nutritional information once you've entered the data into your personal food 
database. The registered version of the software does not set an upper limit on the number of food items 
in the user's personal database.

Choosing Personal Food Database from the Options menu will display all food items from your    database
in the list box. This mode is convenient when your diet consists mainly of special food items or when you 
just want to browse the contents of your data.

See also Edit User's Food Database



Edit User's Food Database

Starting with version 4.2, all of our software products offer a convenient dialog to add food to the user's 
food database. You will need to fill in the food name, its serving designation (1 cup, 1 fruit, etc.), its food 
group (for pyramid analysis) and nutrient information and click the 'Add' button.

We have also made it very easy for you to customize the existing food data or add recipes without having 
to obtain all the nutrient information or retyping it.

Customizing existing food entries:    You can copy existing food entries from the program's standard 
food database, modify them then add these entries to your personal database. For example the 
hamburger you make at home is especially low in sodium. You can create an entry for this item by 
selecting a similar hamburger entry from the standard database and add it to a blank meal. When you 
bring up the Edit Food Database dialog box, its nutrient information will have been filled in for your 
modification. Just reduce the sodium content, give the entry a name then click on 'Add'.

Adding recipes to user's database:    Suppose your favorite snack is a glass of milk and a couple of 
almond cookies. Just select a blank meal, add these    items to it, then bring up the Edit Food Database 
dialog box. The nutrient data in the dialog box are those of all the items in this meal.

Food Group Selection:
Please select Group 1 only if an item belongs to the Sweets category. The number of Fats servings is 
calculated automatically for you so do not specify 1 for a Fat item. 

Important: Every entry in your personal food database should reflect one serving of that food. This allows 
the food pyramid analysis to accurately calculate the number of servings of each food group in your diet. 
If you don't know the weight of one serving of your food, you should use an approximation.

Format of the user's food database 
[Read this section only if you wish to edit the    personal food database    using a text editor or by exporting
data from a database software.]

The user food database is a file named 'userfood.txt'. The file can be edited using any plain text editor 
such as the Windows notepad program. A NotePad icon is created for you during the installation of the 
program to facilitate the editing of this file. You can also use a database program such as Access, FoxPro,
or Paradox, etc. to create this database and export/save the database to/in the plain text format. 

A sample format of each record (entry, line) in this database is:
- food name in double quotes (e.g., "Quarter Pounder with Cheese" )
- weight of 1 serving in grams (e.g., 184 )
- calories from 1 serving in Kcalories (e.g., 560 )
- protein from 1 serving in grams (e.g., 32)
- carbohydrate from 1 serving in grams (e.g., 37)
- total fat from 1 serving in grams (e.g., 30)
- other nutrients ... ...
- food group (1 to 6) (e.g., 3)

Each food item must be stored on a single line and each nutrient information is separated from one 
another by a comma so the above food item is recorded as:
"Quarter Pounder with Cheese", 184, 560, 32, 37, 30, ..., 3
Space(s) before or after the commas is optional. Food group information is recorded last on line.

Water data, when available, are specified in milliliter (ml) or gram (g). One ml of water weighs one gram.

Hint:



Please print out the file 'userfood.txt' for sample entries. The order of the nutrient data follows the order 
of the nutrients as displayed in the main window.
When you add new entries to userfood.txt, it's best to append the new entries to the end of the database 
to maintain the existing order of previously entered foods.
The current maximum length of each entry is 120 characters. The food name, therefore, should be limited
to approximately 80 characters or less.

Food Group Data Entry:
Please note that there are 6 pyramid food groups:
Group 1: Fats and Sweets
Group 2: Milk, Yogurt, and Cheese
Group 3: Meats, Poultry, Fish, Dry Beans and Peas, Eggs, and Nuts
Group 4: Vegetables
Group 5: Fruits and Juices
Group 6: Breads, Cereals, Rice and Pasta

Enter 2 for items belong to Group 2. Enter 3 for Group 3, and so on.

Important:
Please enter 1 (for Group 1) only if an item belongs to the Sweets category. The number of Fats servings 
is calculated automatically for you so do not specify 1 for a Fat item. 

If an item doesn't belong to any food group, please enter 0.



Serving amount

If necessary, you can adjust the amount consumed for a food item by typing the desired amount in grams 
in the edit control above the 'Am(oun)t. OK' button. Once the right amount has been typed in, click on 
'Amt. OK' to confirm and record this value.

For your convenience, we have provided 2 popup menus which you can use to quickly adjust the amount 
of servings:

- a left mouse button click anywhere on the background of the document window will display a selection of
common serving sizes. If the serving size is 1 cup (the serving size or unit is enclosed in square brackets,
for example, [1 cup]), selecting .5 indicates that you consume half a cup of a particular food item. How 
much half a cup weighs and the nutrient contents of this amount of food are adjusted and recorded 
automatically for you. You can turn off this feature via the Options menu.

- a right mouse button click will display a selection of common servings in grams, ounces, or common 
serving sizes. When you release the mouse button after selecting an amount, the amount in the edit box 
and other data will be updated automatically. You can also choose the preferred input type via the Options
menu.



Quick Serving Entry in Ounces

This option allows you to hold down the right mouse button on the main window's background and select 
one of the standard serving sizes in ounces for quick data input.



Quick Serving Entry in Grams

This option allows you to hold down the right mouse button on the main window's background and select 
one of the standard serving sizes in grams for quick data input.



Quick Serving Entry in Common Serving Sizes

This option allows you to hold down the right mouse button on the main window's background and select 
one of the standard serving sizes for quick data input.



Sorting:

You can quickly identify food items high or low in certain nutrients by sorting them. Since the nutrient 
values are those contained in 100g of each food item, you can directly compare different items and easily 
select the appropriate foods to meet your dietary requirement.

clicks this icon to sort the items in the listbox in ascending order. A selection menu will appear to let you 
specify which particular nutrient you want to sort on.

clicks this icon to sort the food items in descending order.

indicates the food items are sorted in ascending order, click on a food item in the listbox to see the 
nutrient's value.

indicates the food items are sorted in descending order, you can click on a food item to view the particular
nutrient's content.



Desirable Weight

This utility calculates the normal weight based on a person's height, sex and age. 

If you are too fat or too thin, your chances of developing health problems are increased.
Being too fat is common in the United States. It is linked with high blood pressure, heart disease, stroke, 
the most common type of diabetes, certain cancers, and other types of illness.
Being too thin is a less common problem. It occurs with anorexia nervosa and is linked with osteoporosis 
in women and greater risk of early death in both women and men.

Whether your weight is 'healthy' depends on how much of your weight is fat, where in the body the fat is 
located, and whether you have weight-related medical problems, such as high blood pressure, or a family 
history of such problems.

What is a healthy weight for you? There is no exact answer right now. Researchers are trying to develop 
more precise ways to describe healthy weight. In the meantime, you can use this utility to help judge if 
your weight is healthy. Find out if your weight is within the normal range. The range is higher for people 
35 years or older than for younger adults. This is because recent research suggests that people can be a 
little heavier as they grow older without added risk to health. Just how much heavier is not yet clear. The 
weight ranges given by the utility are likely to change based on research under way. The current data are 
derived from Diet and Health (National Research Council, 1989).
Ranges of weight are given by this utility because people of the same height may have equal amounts of 
body fat but differ in muscle and bone. The higher weights in the ranges are for people with more muscle 
and bone.
Weights above the range are believed to be unhealthy for most people. Weights slightly below the range 
may be healthy for some small-boned people but are sometimes linked to health problems, especially if 
sudden weight loss has occurred.
Please consult with your doctor to find out what is the optimal weight for you. Because individuals differ, 
your optimal weight may be lower or higher than the normal range.

Use the spin controls in the dialog box to specify your height (without shoes). Specify your sex and age by
selecting the appropriate radio buttons.
To plan your weight loss use Weight Control Plan.

If you close the dialog box by clicking the OK button, the information will be saved and redisplayed next 
time you invoke the dialog box. Use the Esc key to close the dialog box without saving.



Set Fat Warning Level

"Because fat contains more than twice the caloric value per gram of either protein or carbohydrate, the
general public would benefit from reduced fat intake." 

U.S. Surgeon General

Is this food too fatty? Use this dialog box to set the threshold when the program should warn you when a 
food item exceeds the limit. A green or red symbol is displayed appropriately. You can click on the symbol 
to invoke the dialog box.

When you print out your nutritional analysis of your diet, each fatty food will also be marked with an 
asterisk for easy recognition.



Caloric Need and Nutrient Requirements

This dialog box calculates your daily caloric need and recommended intakes of important nutrients 
according to your age, ideal weight, activity level. Please note that the recommended values are for an 
average healthy individual, your optimal intakes may differ. If you have special nutrition requirements, 
please consult your physician or nutritionist.

Specify your age, ideal weight and activity level using the spin buttons. Activity level ranges from 1 
(sedentary) to 10 (strenuous). 

Suggested total fat intake is based on the American Heart Association's and the Food and Nutrition 
Board's recommendation that no more than 30% of your calories come from fat. 

Recommended intakes of other nutrients are based on the Surgeon General's recommendation and on 
the National Research Council's data.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu or hit 
Esc. If you click OK, the current information is saved for next time you invoke the dialog box.

The dialog box must be filled out at least once: when you run the application for the first time, the dialog 
box is automatically presented to obtain your individual information. You can revise the information 
anytime.



Weight Control Planner

It's hard to achieve your weight goal without planning. This utility allows you to establish a plan and 
estimate precisely how much weight you will gain or lose when you follow this plan. 

First, please specify your current weight and activity level by clicking on the appropriate spin controls. The
activity levels range from 1 (for those having sedentary lifestyle) to 10 (for those having physically 
strenuous occupations). The dialog box displays the number of calories required for you to maintain your 
current weight.

The 'Daily consumption' list box (on the right) should contain several files for you to add to your plan (the 
list box on the left). Please note that you must have previously saved some files before you can use this 
dialog box. Or you can try out the sample daily food consumption files we provide.
Let's assume you've prepared 7 daily menus and name them Sun, Mon, Tue, etc. [The program 
automatically adds in the standard extension for your files, please use the standard extension.] These 
files should appear on the right hand side list box. You add the files one by one to your plan by selecting 
them then click on the 'Add to Plan' button or by double-clicking the file names.
As you add in these files, the dialog box automatically calculate the amount of weight you should gain or 
lose if you follow your plan, the average daily caloric intake and the average fat content of your plan.

NutriGenie weight control plan is truly flexible: you can set a food plan to be repeat every week, every 3 
days or every 10. You can also anticipate your future weight when your plan is repeated during this period
by adjusting the number of days in the period via the spin control.

Once an entry is added into your plan, you can select it then click on the 'chart' button to review its 
nutritional content. 
In general, you should not try to achieve significant weight loss in just a few days. Please consult your 
physician regarding your weight loss goal. Even an energy deficit of just 500 kcal a day should result in a 
loss of approximately 1 pound per week or 50 pounds a year!

After setting up your plan, print out a report to keep track of your food intake and to motivate yourself to 
achieve your goal.



Nutrient Analysis

Do you know which meal provides you with the most protein in your diet? With the most fat? This graph 
displays the percentage of each nutrient consumed during each meal of the day.

Select 'Protein' from the combo box and the graph shows the percentage of protein that comes from 
breakfast, morning snack, lunch, afternoon snack, dinner and evening snack in counter clockwise order. 

The analyses are provided for weight, calories, protein, carbohydrate, fat, and other essential nutrients 
when available. These analyses are very convenient when you want to spread out your energy intake 
throughout the day instead of concentrate your food consumption in infrequent big meals. In addition, it is 
easier for the gastrointestinal tract to absorb nutrients from small amounts of food over small periods of 
time.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu or hit 
Esc. If you click OK, the currently selected nutrient will also be initially selected next time you invoke the 
dialog box.



Caloric Analysis

These 2 graphs provide information about the nutrient contents of your food intake for the current day or 
for that previously saved in a file.

The left graph shows the weight in grams of protein, carbohydrate and fat in the day's food consumption. 
The right graph shows the day's caloric intake and a pie chart depicting the percentages of calories from 
protein, carbohydrate and fat in counter clockwise order. Each nutrient is color coded for easy 
identification. Please note that throughout this program, the percentages of calories from fat, protein and 
carbohydrate are relative to one another, energy contribution from alcohol is included in the total energy 
figure but excluded from the percentage calculation.

You should pay particular attention to the percentage of calories from fat. The American Heart Association
recommends that your total fat intake be no more than 30 percent of your total calories.

To leave the graphs click the mouse anywhere inside them or hit the escape key.



Set Fat Warning Level

This option allows you to specify the percentage of calories from fat above which you want to be alerted. 
For example, if you want to identify foods that has more than 50% of their calories derived from fat, you 
should set this value through the Set Fat Warning Level dialog box. From then on, each time a food item 
is consumed, a green or red symbol will be displayed to indicate whether its fat content is below or above 
the limit you set. When you print out your nutritional report, each food item exceeding this limit is also 
flagged with an asterisk before its name.

indicates food item does not exceed user-specified percentage of calories from fat.

indicates food item exceeds user-specified percentage of calories from fat.



Set Nutrient Intake Preference

How much of each nutrient do you want to consume each day? Use this dialog box to set your own 
preference. The color of the RDA analysis bars will reflect your preference. The bars are green when you 
consumption is within your preferred range, yellow when you are not having enough of a nutrient, 
magenta when your intake is somewhat above the optimal range, and red when the consumption is 
considerably higher than desired.

Click on the Use RDA button if you want the Recommended Dietary Allowance value for any particular 
nutrient. Please note that the RDA values are for an average individual. You might need to adjust your 
optimal intake accordingly.



Caloric Analysis

Do you need a more healthful diet? This menu item displays a graph showing the number of calories in 
your diet that comes from protein, carbohydrate or fat. Please note that throughout this program, the 
percentages of calories from fat, protein and carbohydrate are relative to one another, energy contribution
from alcohol is included in the total energy figure but excluded from the percentage calculation.



Nutrient Analysis

Are you eating too much at dinner and not enough at breakfast? Check out the relative nutrient intakes of 
all your daily meals.



Weight Control Plan

It is now so easy to establish a sensible plan to control your weight. Your plan can be set for any number 
of days. Find out how much weight you will gain or lose in a week, a month or a year; and whether you 
are consuming too much fat in your plan.



Caloric Need

Find out how many calories you need a day based on your age, desirable weight and activity level. The 
dialog box also shows the maximum recommended fat consumption in your diet.



Desirable Weight

This menu item displays a dialog box which allows you to determine your ideal weight based on your sex, 
height and body frame.



Find Food Item with Lowest Content of a Nutrient

Click this button to search for food item in your day consumption that has the lowest amount of a 
particular nutrient. The food item is highlighted and the meal where it is consumed is selected. This is 
useful when you want to keep the consumption of a particular nutrient low. For example, you can find food
items with lowest fat content and consume more of these items without worrying about quickly increasing 
your fat intake. If your day's consumption has several items with the same low fat content in different 
meals, the program cycles through these items each time you click on this button.



Find Food Item with Highest Content of a Nutrient

Click this button to search for food item in your day consumption that has the highest amount of a 
particular nutrient. The food item is highlighted and the meal where it is consumed is selected. This is 
very useful when you want to quickly lower or raise the consumption of a nutrient. For example, your day 
consumption is too high in fat. You can use this button to identify the food item that most contributes to the
high fat content and adjust your consumption of this item accordingly.



Choose Printer Font

Use this option to select the printer font for your Nutritional Analysis Report and Weight Planning Report.



Choose Screen Color

Some monitors flicker noticeably when certain colors are displayed. Use this option to select the most 
pleasing color for your screen background.



Body Mass Index

Are you thin, or are you overweight? This dialog box uses the Body Mass Index (BMI) which is derived 
from your height (without shoes) and weight (without clothes) to chart your precise standing. Compare 
your BMI with that of an average person, or an obese individual.

Relative body weights above 100 to 109 percent of desirable are associated with increased mortality as 
well as morbidity from heart disease, cancer, diabetes, digestive diseases, and cardiovascular disease. 
The higher the relative weight, the greater the risk for these conditions. Rates of hypertension and 
diabetes are nearly tripled for persons 20 percent or more overweight, and hypercholesterolemia was 50 
percent more common. The large American Cancer Society Study found mortality from various causes to 
increase according to the degree of overweight. Of all obesity-related diseases, noninsulin-dependent 
diabetes is most clearly and strongly associated with obesity. Many other serious conditions such as 
gallstones, sleep apnea, osteoarthritis, and other disabling disorders of locomotion bear a direct 
relationship to obesity.



Caloric Expenditure of Common Activities

This utility allows you to calculate how many calories you burn by exercising or by doing many of the 
usual daily activities. The registered database contains information on 130 common activities. You should 
select an activity and set it (via the 'Set Favorite Activity' button) as your favorite activity. Once this has 
been set, each time you consume a food item, its caloric equivalence in terms of your favorite activity is 
calculated and displayed on the status bar at the bottom of your screen. For example, you set Tennis as 
your favorite activity and you weigh 160 lbs.; when you drink a cup of milk, the caloric equivalence of this 
food item is 18 minutes of Tennis. This means it takes you 18 minutes of playing tennis to burn away the 
calories contained in one cup of milk!

Another interesting piece of information the Caloric Expenditure dialog box provides is how much exercise
it takes to lose one pound of weight. Let's say you weigh 155 lbs. and usually play tennis for an hour each
time you get to play. The dialog box figures out you need to repeat this activity (an hour of tennis) 7 times 
to burn away one pound of weight, everything else being equal. Please note that this is not an advice for 
you to go out and play tennis 7 times to achieve this weight reduction! The information is presented so 
that you can have another measure of the relationship between weight loss and physical exercise. Before 
embarking on any exercise program, you should obtain approval from your doctor.



Show CSI

This option, available in Lower Your Cholesterol, toggles the display of the Cholesterol Saturated Fat 
Index.



Reverse Food Groups

This command reverse the current display order of the food group names in the Food Group drop down 
list box.



Food Guide Pyramid

This dialog box displays the Food Guide Pyramid analysis of your current diet. If your diet is balanced and
varied, the result should resemble a well-formed pyramid where the base is larger than the top.

The USDA recommended number of servings is for an average individual; you may want to consult with 
your doctor to design an optimal personal diet program. The RDA and caloric counters of this program 
can also serve as a guide.

To arrive at your ideal weight, you may need to change your current approach to eating. Permanent 
weight loss is most easily achieved with a varied, balanced and nutritious diet that is low in fat and in 
empty calories. Use this Pyramid Food Analysis to help you identify imbalanced or restrictive diet.

Please note that you can add your own favorite foods to the user's food database and specify a food 
group for each of these foods. The registered version of this software does not set a limit on the number 
of entries in the user's food database.

Note: This feature is available only in the NutriGenie series and the following program:
Pyramid Weight Loss Diet



Target Heart Rate

This utility helps you determine if your heart is fit. During your next workout, take a break from your 
routine and take your pulse for 10 seconds to measure the intensity of your workout. Refer to the dialog 
box: if this number is within your Target Heart Rate then you are heart fit and your workout is efficient. 
When exercise, you should aim for your Target Heart Rate because you will get the maximum benefit 
from your exercise.

Your heart rate typically has a maximum value according to your age. This means your heart doesn't beat 
faster than this rate no matter how strenuously you exercise. Normally, you should try to reach from 65 to 
85% of this heart rate from your exercise. Below this range, you are not exercising hard enough; above it, 
you might want to take it easy while working out. The 85% maximum heart rate is for athlete in training.

User over 40 years old or those with heart problem should definitely consult with their doctors and have a 
stress electrocardiogram performed before adopting any exercise program.



Weight Tracker (also GFR or Blood Sugar Tracker)

This utility allows you to keep track of your weight loss progress over time. It can accommodate many 
users and although its primary purpose is for weight tracking, you can use its graphing and convenient 
data entry capabilities to keep track of other information too.

Begin by creating a log for yourself using your name, for example. Once a user's log has been created, 
you type in the initial weight in the weight recording edit control. Afterwards, the easiest way for data entry
is to click and drag the mouse on the background of the dialog box to select the desired weight. Make 
sure you save or click OK before closing the dialog box to retain the data for next time. Or hit 'esc(ape)' to
cancel the data entry. Normally you enter the data weekly. You can also enter the data every few days. 
Please just make sure that the data are entered regularly enough so that the shape of the graph 
accurately reflects your progress.

The Glomerular Filtration Rate (GFR) and Blood Sugar Trackers work similarly.

Note: The default unit for recording blood glucose is mg/dl. The utility is unit independent and you can use
it for recording measurements in mmol/dl also. However, since the utility accepts only integer values, you 
might want to uniformly multiply the mmol/dl values by 10 before recording them.



Diet Tracker

This utility allows you to keep track of your diet over time. You can keep track of the diet for many users 
using this dialog box. Make sure you save or use the OK button to save the data when exit. Select one of 
the files in the combo-box and add it to your diet log.
You can view the diet history in 2 formats: absolute calories or percentage calories contributed from fat, 
carbohydrate and protein. The dialog box also displays a running average of percentages of calories from
fat, carbohydrate and protein as well as the average daily caloric intake for the whole period.



Average Caloric Content of Diet

What is important is not a single day's diet but your cumulative diet. This dialog box shows you the 
average caloric content of your diet that comes from each of the following nutrients: fat, carbohydrate and 
protein; a relative percentage value is also given. The percentages may not add up to exactly 100% 
because of truncation. Please also note that throughout this program, the percentages of calories from 
fat, protein and carbohydrate are relative to one another, energy contribution from alcohol is included in 
the total energy figure but excluded from the percentage calculation.



Mouse Button Option

You can quickly input food amount by clicking either the left or right mouse button on the screen and 
select the desired amount by dragging the mouse then releasing its button at the appropriate selection. 
The selection can be set to be in serving portion, gram or ounce. You can also turn this option off. 
The 'Am(oun)t OK' button needs to be used only when you want to specify an exact weight by typing the 
amount in the edit control above this button. Otherwise using the mouse is more convenient.



Glucose Log

This utility allows you to keep track of your blood glucose levels over time. You begin by creating a list of 
the times when you normally measure your glucose each day. For example, 8 AM, 10 AM, 2 PM, etc. You 
can also name these periods more descriptively: Fasting BG, After Lunch BG, etc. Afterwards, you add 
the daily glucose measurement that correspond to a period to the log. The resulting graph will show the 
accumulating data over time.

Initially, you should freely experiment with the log by creating and deleting different time periods and using
the mouse to enter the data (by clicking on the dialog's window and selecting from the popup menu). 
Once you've established a regular pattern, you should record the data daily for each time period.



Blood Pressure Log

This utility allows you to keep track of your blood pressure over time. Begin by creating an entry for 
yourself (the dialog supports multiple users), then enter your systolic and diastolic readings in the 
appropriate edit controls and click on 'Add'. You should measure your blood pressure at regular time 
intervals (weekly or monthly, for example). The utility also classify your readings into one of the following 
categories: Optimal, Normal, High Normal, and Stage 1 through Stage 4 Hypertension.



Select Nutrients to Print

When the number of nutrients analyzed by the program is large, user has the option of selecting a subset 
of the nutrients for print output. This allows the selection of a larger font size when printing. Another option
is to use the landscape print mode which provides more space per horizontal line.
In this dialog box, only the checked nutrients are printed.



Set NutriGenie Options

Use this dialog box to specify the desired caloric intake level for NutriGenie. The menus generated by 
NutriGenie, in almost all cases, are within +/- 10 Calories of user's specification.

Please note that the menus generated by NutriGenie are intended for an average healthy individual. If 
you have special dietary requirements, you may have to modify the generated menus to fit your needs.



Caloric Need of Infants

This dialog box calculates the caloric needs and essential nutrient requirements of infants in their first 
year.



Dialog Boxes

This is a comprehensive list of dialog boxes in NutriGenie programs. Not all dialog boxes are available in 
every program. Please refer to each program's feature list for further information.

Add Foods or Recipes to Database
Body Mass Index
Blood Glucose Log
Blood Pressure Log
Caloric Analysis
Caloric Expenditure
Cholesterol Profiler
Choose Printer Font
Choose Screen Color
Diet Tracker
Establish Weight Reduction Plan
Exchange Options and Auto Menu Generator
Find Desirable Weight
Find Caloric and Nutrient Requirements
Food Pyramid Analysis
Glomerular Filtration Rate (GFR) Tracker
Infants Caloric Requirement
Mouse Button Option
Nutrient Analysis
Rename Personal Food Groups
Review Food Lists
Select Nutrients to Show in VGA Mode
Select Nutrients to Print
Set Fat Warning Level
Set NutriGenie Options
Set Nutrient Intake Preference
Target Heart Rate
Weight Tracker



Glossary

Atherosclerosis: A type of "hardening of the arteries" in which cholesterol, fat, and other blood 
components build up in the walls of arteries. As atherosclerosis progresses, the arteries to the heart may 
narrow so that oxygen-rich blood and nutrients have difficulty reaching the heart.

Carbohydrate: One of the three nutrients that supply calories (energy) to the body. Carbohydrate 
provides 4 calories per gram -- the same number of calories as pure protein and less than half the 
calories of fat. Carbohydrate is essential for normal body function. There are two basic kinds of 
carbohydrate -- simple carbohydrate (or sugars) and complex carbohydrate (starches and fiber). In 
nature, both the simple sugars and the complex starches come packaged in foods like oranges, apples, 
corn, wheat, and milk. Refined or processed carbohydrates are found in cookies, cakes, and pies, etc.

Cholesterol: A soft, waxy substance. It is made in sufficient quantity by the body for normal body 
function, including the manufacture of hormones, bile acid, and vitamin D. It is present in all parts of the 
body, including the nervous system, muscle, skin, liver, intestines, heart, etc.

Blood cholesterol--Cholesterol that is manufactured in the liver and absorbed from the food you eat 
and is carried in the blood for use by all parts of the body. A high level of blood cholesterol leads to 
atherosclerosis and coronary heart disease.

Dietary cholesterol--Cholesterol that is in the food you eat. It is present only in foods of animal 
origin, not in foods of plant origin. Dietary cholesterol, like dietary saturated fat, tends to raise blood 
cholesterol, which increases the risk for heart disease.

Coronary heart disease: Heart ailment caused by narrowing of the coronary arteries (arteries that supply
oxygen and nutrients directly to the heart muscle). Coronary heart disease is caused by atherosclerosis, 
which decreases the blood supply to the heart muscle. The inadequate supply of oxygen-rich blood and 
nutrients damages the heart muscle and can lead to chest pain, heart attack, and death.

Fat: One of the three nutrients that supply calories to the body. Fat provides 9 calories per gram, more 
than twice the number provided by carbohydrate or protein. In addition to providing calories, fat helps in 
the absorption of certain vitamins. Small amount of fat are necessary for normal body function.

Total fat: The sum of saturated, monounsaturated, and polyunsaturated fats present in food. A mixture of 
all three in varying amounts is found in most foods.

Gram: A unit of weight. There are about 28 grams in 1 ounce. Dietary fat, protein, and carbohydrate are 
measured in grams.

Lipids: Fatty substances, including cholesterol and triglycerides, that are present in blood and body 
tissues.

Lipoproteins: Protein-coated packages that carry fat and cholesterol through the blood. Lipoproteins are 
classified according to their density.

High density lipoproteins (HDL)--Lipoproteins that contain a small amount of cholesterol and carry 
cholesterol away from body cells and tissues to the liver for excretion from the body. Low levels of 
HDL are associated with an increased risk of coronary heart disease. Therefore, the higher the HDL 
level, the better.

Low density lipoproteins (LDL)--Lipoproteins that contain the largest amount of cholesterol in the 
blood. LDL is responsible for depositing cholesterol in the artery walls. High levels of LDL are 
associated with an increased risk of coronary heart disease and are therefore referred to as "bad 



cholesterol".

Osteoporosis: a condition in which the calcium content of the bones is depleted over time such that the 
bones become brittle and can be fractured with even minimal trauma.

Protein: One of the three nutrients that supply calories to the body. Protein provides 4 calories per gram, 
which is less than half the calories of fat. Protein is an essential nutrient that becomes a component of 
many parts of the body, including muscle, bone, skin, and blood.

Recommended Dietary Allowances (RDAs): the levels of intake of essential nutrients that, on the basis 
of scientific knowledge, are judged by the Food and Nutrition Board to be adequate to meet the known 
nutrient needs of practically all healthy persons. [Individuals with special nutritional needs are not covered
by the RDAs.]

Triglycerides: Lipids (fat-like substances) carried through the bloodstream to the tissues. The bulk of the 
body's fat tissue is in the form of triglycerides, stored for later use as energy. We get triglycerides primarily
from the fat in our diet.

Vascular disease: An ailment of the blood vessels often caused by atherosclerosis. Vascular disease 
may occur in the arteries to the brain and the major leg arteries.



anorexia: loss of appetite.



ataxia: loss or lack of muscular coordination.



tachycardia: excessively rapid heartbeat.



xerosis: abnormal dryness, esp. of the skin, conjunctiva, or mucous membranes.



dermatitis: inflammation of the skin.



Proteins

The primary function of protein is to build body tissue and to synthesize enzymes, some hormones, and 
other complex substances that govern body processes.

Proteins are usually readily available from both animal and plant sources. Of the 20 amino acids that 
make up protein, 8 are considered essential because the body cannot synthesize them and must be 
supplied ready-made in foods. If these essential amino acids are not all present, the other amino acids 
cannot be used for metabolizing human protein. Therefore, a diet containing these essential amino acids 
is very important for sustaining growth and health. Foods from animal sources contain complete proteins 
because they include all the essential amino acids. In most diets, a combination of plant and animal 
protein is recommended.
    
"Where protein intake is exceptionally low, there are physical signs--stunting, poor musculature, edema, 
thin and fragile hair, skin lesions--and biochemical changes that include low serum albumin and hormonal 
imbalances." [NRC]



Minerals

Inorganic mineral nutrients are required in the structural composition of hard and soft body tissues; they 
also participate in such processes as the action of enzyme systems, the contraction of muscles, nerve 
reactions, and the clotting of blood. These mineral nutrients, all of which must be supplied in the diet, are 
of two classes: the major elements such as calcium, phosphorus, magnesium, iron, iodine, and 
potassium; and trace elements such as copper, cobalt, manganese, fluorine, and zinc. Trace elements 
appear in the body in minute amounts and are essential for good health. Little is known about how they 
function, and most knowledge about them comes from how their absence affects health.



Vitamins

Vitamins are organic compounds that mainly function in enzyme systems to enhance the metabolism of 
proteins, carbohydrates, and fats. Without these substances, the breakdown and assimilation of foods 
could not occur. Vitamins are classified into two groups, the fat-soluble and the water-soluble vitamins. 
Fat-soluble vitamins include vitamins A, D, E, and K. The water-soluble vitamins include vitamin C and the
B-vitamin complex. 

Fat-soluble vitamins are usually absorbed with foods that contain fat. Excess amounts are stored in the 
body's fat and in the liver and kidneys. Because fat-soluble vitamins can be stored, they do not have to be
consumed every day. The water-soluble vitamins, C and B complex, cannot be stored and therefore need 
to be consumed daily to replenish the body's needs. The body can manufacture only vitamin D; all others 
must be derived from the diet. Lack of them causes a wide range of metabolic and other dysfunctions.



Carbohydrates

Carbohydrates are the human body's main source of both quick and sustained energy. Carbohydrates are
burned during metabolism to produce energy, releasing carbon dioxide and water. Humans also get 
energy from fats and proteins in the diet, and also from alcohol. 
The carbohydrates containing the most nutrients are the complex carbohydrates, such as unrefined 
grains, tubers, vegetables, and fruit, which also provide protein, vitamins, minerals, and fats. A less 
beneficial source is foods made from refined sugar, such as candy and soft drinks, which are high in 
calories but low in nutrients and fill the body with what nutritionists call empty calories. 



Fats

Fats are essential to the body as energy sources and as a component of hormones and membranes, but 
excessive intake may contribute to arteriosclerosis, colon cancer, and gallstones. Fats produce more than
twice as much energy as carbohydrates. Being a compact fuel, fat is efficiently stored in the body for later 
use when carbohydrates are in short supply. In industrial nations such as the U.S., with food always 
available and with machines replacing human labor, the accumulation of body fat has become a serious 
health concern. 



Vitamin A

Vitamin A affects the formation and maintenance of skin, mucous membranes, bones, and teeth; vision; 
and reproduction. Vitamin A can be obtained directly in the diet from foods of animal origin such as milk, 
eggs, and liver. Excess vitamin A can interfere with growth, stop menstruation, damage red blood cells, 
and cause skin rashes, headaches, nausea, and jaundice.

Deficiency:
"Prominent clinical signs [of vitamin A deficiency] are ocular, and range from night blindness and 
conjunctival xerosis to corneal xerosis, ulceration, and sometimes liquefaction... Other less specific 
deficiency signs may include loss of appetite, hyperkeratosis, increased susceptibility to infections..." 
[NRC]
An early deficiency symptom is night blindness (difficulty in adapting to darkness); other symptoms are 
excessive skin dryness; lack of mucous membrane secretion, causing susceptibility to bacterial invasion; 
and dryness of the eyes due to a malfunctioning of the tear glands, this is a major cause of blindness in 
children in developing countries.



Vitamin B-6

Pyridoxine, or vitamin B6, is necessary for the absorption and metabolism of amino acids. It also plays 
roles in the use of fats in the body and in the formation of red blood cells. Pyridoxine is needed in 
proportion to the amount of protein consumed. 

Deficiency:
"Clinical signs of deficiency include epileptiform convulsions, dermatitis, and anemia. Deficiency in infant 
leads to a variety of neurological symptoms as well as abdominal distress." [NRC]
Pyridoxine deficiency is commonly characterized by skin disorders, cracks at the mouth corners, smooth 
tongue, convulsions, dizziness, nausea, anemia, kidney stones, depression, extreme nervousness, water 
retention, lethargy.



Vitamin B-12

Vitamin B-12 is necessary in minute amounts for the formation of nucleoproteins, proteins, and red blood 
cells, and for the functioning of the nervous system. Vitamin B-12 is obtained only from animal sources 
such as liver, kidneys, meat, fish, eggs, and milk. Vegetarians should consider taking vitamin B-12 
supplements. 

Deficiency:
"Vitamin B-12 deficiency results in macrocytic, megaloblastic anemia, in neurological symptoms due to 
demyelination of the spinal cord and brain and the optic and peripheral nerves, and in other less specific 
symptoms (e.g., sore tongue, weakness)." [NRC]
Common symptoms of deficiency: anemia, heart palpations, sore tongue, general weakness, lethargy.



Vitamin C

Vitamin C, or ascorbic acid, is important in the synthesis and maintenance of connective tissue. It 
prevents scurvy, which attacks the gums, skin, and mucous membranes, and its main source is citrus 
fruits. 
Ascorbic acid has been shown to prevent the formation of nitrosamines (compounds found to produce 
tumors) in laboratory animals and possibly also in humans. Although unused ascorbic acid is quickly 
excreted in the urine, large and prolonged doses can result in the formation of bladder and kidney stones,
interference with the effects of blood-thinning drugs and the loss of calcium from bones.

Deficiency:
"Dietary deficiency leads to scurvy, a serious disease characterized by weakening of collagenous 
structures that results in widespread capillary hemorrhaging. In the United States, scurvy occurs primarily 
in infants fed diets consisting exclusively of cow's milk and in aged persons on limited diets." [NRC]
Other symptoms of vitamin C deficiency: easy bruising; spongy, bleeding gum; dental problems; slow 
wound healing; fatigue; listlessness; rough skin.



Iron

Iron is needed to form hemoglobin, which is the pigment in red blood cells responsible for transporting 
oxygen. Women of menstrual age, who need nearly twice as much iron as men do because of blood loss,
often have iron deficiencies. 

Deficiency:
"An association between hemoglobin concentration and work capacity is the most clearly identified 
functional consequence of iron deficiency. Iron deficiency has also been associated with decreased 
immune function as measured by changes in several components of the immune system during iron 
deficiency... In children, iron deficiency has been associated with apathy, short attention span, irritability, 
and reduced ability to learn." [NRC]
Other common signs of iron deficiency: anemia,    weakness, fatigue, headache, heart palpations, mouth 
soreness.



Magnesium

Magnesium is essential for human metabolism and is important for maintaining the electrical potential in 
nerve and muscle cells.

Deficiency:
"The most prominent and consistent signs [of magnesium deficiency are] nausea, muscle weakness, 
irritability, mental derangement, and myographic changes." [NRC] 
A deficiency in magnesium among malnourished persons, especially alcoholics, leads to tremors and 
convulsions, foot and leg cramps, irregular pulse, nervousness.



Niacin

Or vitamin B3, also works as a coenzyme in the release of energy from nutrients. The best sources of 
niacin are liver, poultry, meat, canned tuna and salmon, whole grain and enriched cereals, dried beans 
and peas, and nuts.

Deficiency:
A deficiency of niacin causes pellagra, the first symptom of which is a sunburn-like eruption that breaks 
out where the skin is exposed to sunlight. Later symptoms are a red and swollen tongue, diarrhea, mental
confusion, irritability, and, when the central nervous system is affected, depression and mental 
disturbances. In large amounts it reduces levels of cholesterol in the blood, and it has been used 
extensively in preventing and treating arteriosclerosis. However large doses over long periods can cause 
liver damage. 



Phosphorus

Phosphorus combines with calcium in the bones and teeth. It plays an important role in energy 
metabolism of the cells, affecting carbohydrates, lipids, and proteins.

Deficiency:
"Serious phosphorus deficiency has been induced in patients receiving aluminum hydroxide as an antacid
for prolonged periods. Aluminum hydroxide binds phosphorus, making it unavailable for absorption. 
Phosphorus deficiency results in bone loss and is characterized by weakness, anorexia, malaise, and 
pain." [NRC]



Riboflavin

Or vitamin B2 is an orange-yellow crystalline compound, the principal growth-promoting factor in the 
vitamin B complex, naturally occurring in milk, leafy vegetables, fresh meat, and egg yolks. Like thiamin, 
riboflavin serves as a coenzyme in the metabolism of carbohydrates, fats, and, especially, respiratory 
proteins. It also serves in the maintenance of mucous membranes.

Deficiency:
Riboflavin deficiency may be complicated by a deficiency of other B vitamins; its symptoms are skin 
lesions, especially around the nose and lips, and sensitivity to light resulting in burning, itchy eyes.



Thiamin

Thiamin, or vitamin B1, is a colorless, crystalline substance, it acts as a catalyst in carbohydrate 
metabolism, enabling pyruvic acid to be absorbed and carbohydrates to release their energy. Thiamin 
also plays a role in the synthesis of nerve-regulating substances.

Deficiency:
"The clinical condition associated with the prolonged intake of a diet low in thiamin is traditionally called 
beriberi, whose primary symptoms involve the nervous and cardiovascular systems. The characteristic 
signs include mental confusion, anorexia, muscular weakness, ataxia, peripheral paralysis, 
ophthalmoplegia, edema (wet beriberi), muscle wasting (dry beriberi), tachycardia, and enlarged heart." 
[NRC]



Zinc

A component of enzymes that involve in most metabolic pathways, zinc is an essential element for plants,
animals and humans.

Deficiency:
"The sign and symptoms of dietary zinc deficiency in humans include loss of appetite, growth retardation, 
skin changes, and immunological abnormalities." [NRC] Marginal zinc deficiency in apparently healthy 
children results in "suboptimal growth, poor appetite, and impaired taste acuity. Increasing the daily zinc 
intake by 0.4 to 0.8 mg/kg brought about marked improvement." [NRC]
Deficiencies of both zinc and iron can be a problem in a vegetarian diet, especially for women, these can 
result in slow wound healing, skin and hair problems as well as poor resistance to infection.



Frequently Asked Questions

General
Technical



Frequently Asked Questions: General

Q. What are the benefits of registering this software?
A. 
1. Registered users receive an upgraded diskette having an expanded food database. Please note that 
we use several food databases and they differ in size. In addition, we regularly update our programs and 
data and will send you the most current version.

2. The registered version of the software processes all food items in the user's personal database. In the 
shareware version, you can prepare as large a personal food database as you have data for but the 
program makes use of (sorts, searches or displays) only the first several entries in this database.

3. In addition to free technical support, registered users receive deep discount on future registrations of 
NutriGenie products. Fee for upgrading to later version of the same program is also minimal.

Q. How can I register for NutriGenie software?
A. You can register by mail, by phone using credit card, or through the CompuServe Shareware 
Registration Service. Please see the registration topic for more information.

Q. Is this version the latest?
A. We always send registered users the latest version of the titles they ordered. Although some minor 
revisions are not reuploaded to ftp sites and online services, you can always send us an email message 
for confirmation or visit our WWW page at http://pages.prodigy.com/CA/nutrigenie/ for the current 
software list.

Q. Which NutriGenie program is best for me?
A. You may want to use the following steps to select the software:
1. select the program that analyzes all the nutrients and has all the features you require, if there is 

more than one
2. select the program that has the larger food database, then
3. select the program that has the later version number, then
4. select the program that costs less.
To see all features offered in a program, the nutrients it analyzes and its database size, please click on 
the program's 'info' in the NutriGenie topic.

Q. How much does it cost to upgrade to newer versions of NutriGenie products?
A. Registered users automatically receive a free upgrade when there is a minor revision of a product. 
When there is a major new release, the standard upgrade cost is 20% of the registration fee. For 
example, registered users of Weight Perfect 2.0 can upgrade to Weight Perfect 3.0 for $7 which is 20% of
the $35 registration fee of this product.

Q. Is there printed manual for this product?
A. Because of frequent updates to our programs, in general, we provide only on-line documentation: this 
help file. While reading this help file you can print out any topic as needed via the 'Print' command on the 
toolbar or 'Print topic' command from the 'File' pull-down menu. 

Q. What is the best way to get in touch with NutriGenie?
A. The best way to get in touch with us is by email. Our Internet addresses are 
71563.124@compuserve.com and NutriGenie@aol.com. Email is usually answered in the same day. If 
you have to use regular mail, please include a phone number.

Q. Where can I obtain other NutriGenie shareware products for evaluation?
A. The most current selection of our software can be downloaded from:
· WWW: http://pages.prodigy.com/CA/nutrigenie/
· CompuServe: the Windows Shareware Forum, Natural Medicine Forum (GO NATMED), and 
Health and Fitness Forum (please search on contributor: 71563,124)



· America Online: the PC Applications Forum (please search on keyword: NutriGenie or NutriSoft)
· Internet FTP: ftp.cica.indiana.edu, the Center for Innovative Computer Applications ftp site of 
Indiana University. Our files are in directory pub/pc/win3/misc or pub/pc/win95/misc (please search on 
file names starting with "ns" or "ng"). Another ftp site which has our latest programs is ftp.coast.net 
(directory SimTel/win3/food).
· To obtain the evaluation software on diskette, please call Shareware (800)-395-7797. There is a 
fee for this service: $8 for the first title, $4 for each additional title, or $20 for up to 10 titles.



Frequently Asked Questions: Technical

Q. What do I do when there is problem running this program?
A. NutriGenie tests its products on the most current versions of Windows before releasing them. All of our 
Windows 3 software have been successfully tested in the following environments:
- Windows 3.1
- Windows for Workgroups 3.11
- Windows NT 3.5
- Windows 95
When there is any incompatibility, it is most likely caused by the existence of older .vbx files or libraries on
your machine. To maintain the integrity of your Windows environment, our installation procedure does not 
overwrite or modify any existing files on your computer. In fact, all NutriGenie-related files are installed to 
a single directory (which you specify) to allow easy deinstallation. Therefore, you will need to take the 
following steps if you wish to update the .vbx files:
1. save all .vbx files that are in your windows or windows\system directories (to another directory or a 
diskette)
2. also save the following 2 files: gsw.exe and gswdll.dll if they exist
3. copy gsw.exe, gswdll.dll and all .vbx files from the directory where you installed this program to the 
windows or windows\system directory
4. restart Windows then rerun this program.
You can always revert to the original state of your Windows environment by copying back the saved .vbx 
files and libraries if desired.

Q. I don't see Vegetables in the food group combo-box, do you have vegetables in your database?
A. Yes, we do have vegetables in our food databases. Depending on the display mode of your computer 
(EGA, VGA, SVGA, etc.) and depending on the database used for a particular program, you may or may 
not see Vegetables in the combobox when you first click on it. There are more food groups (not visible 
because of the limited screen size) further down the combo-box. There are 2 basic ways to access these 
groups:
1. use the reverse food group icon (on the right of the food group combo-box) to show the food groups in 
the reverse order so you can see those at the end of the food groups first.
2. tab to the combo-box and type the first character of the food group you want to see. In this particular 
case, it's the letter 'v'. The food groups will cycle through all those that start with this letter v. You can use 
similar technique to access other food groups.

Q. When do I use the 'Am(oun)t OK' button, or the 'I Eat' button?
A. You rarely need to use these two buttons.
You use the 'Amt. OK' button when you want to accept a specific amount of food which is entered via the 
edit control above this button. Normally, you click the left or right mouse button on the main window to 
select a standardized input amount which is automatically updated for you.
You can either double-click a food item or select it then click on 'I Eat', these operations are equivalent.

Q. What does 'NFS' stand for?
A. Not Further Specified.



Where to find latest NutriGenie software for evaluation

We continuallly upgrade our existing software or release new products. For the latest version or software, 
please visit the following forums or internet sites.

1. CompuServe: the Windows Shareware Forum, Natural Medicine Forum (GO NATMED), and Health 
and Fitness Forum (please search on contributor: 71563,124)

2. America Online: the PC Applications Forum (please search on keyword: NutriGenie or nutrition)

3. Internet FTP: ftp.cica.indiana.edu, the Center for Innovative Computer Applications ftp site of Indiana 
University. Our files are in directory pub/pc/win3/misc or pub/pc/win95/misc (please search on file names 
starting with "ns" or "ng"). Another ftp site which has our latest programs is ftp.coast.net (directory 
SimTel/win3/food).

4. WWW: http://pages.prodigy.com/CA/nutrigenie Our home page has the most up-to-date information 
about our software as well as the latest software for downloading.



About NutriGenie

NutriGenie was established by a group of Stanford University researchers to provide consumers with 
quality software to help them achieve better health. Our products have been licensed by health 
organizations, universities and individual users throughout the world. In addition to numerous top ratings 
by many software reviewers, in June 1995, we received the Home PC Editors' Choice: Top 100 
Products of the Year Award. Your suggestions and comments on our products are much appreciated. 
Please write to us at the following addresses:

US Mail: P.O. Box 8226, Stanford, CA 94309
America Online: NutriGenie
CompuServe: 71563,124
Internet: NutriGenie@aol.com or NutriSoft@aol.com or 

71563.124@compuserve.com

We welcome inquiry from authors, institutions, and publishers who would like to distribute our products or 
customize our software to use with their own nutritional data. We also license our technology (including 
source code) and provide technical consulting services to other nutrition software companies.

Please visit our WWW home page http://pages.prodigy.com/CA/nutrigenie/ for latest information about
our products and evaluation software download.

Partial list of software products released by NutriGenie as of January, 1996:

24. NutriGenie Lower High Blood Pressure for Windows v. 4.4 ($49)
A non-drug dietary approach for lowering high blood pressure based on US Surgeon General's 
guidelines. In addition to the sophisticated NutriGenie technology and unique USDA Food Pyramid 
analysis, this product implements the ADA Food Exchange System for meal planning: the program can 
automatically generate meals according to user's exchange requirements and food selections. Unique 
analysis of K Factor.
This package includes Omega-3 Counter and has utilities to keep track of blood pressure as well as 
weight log and diet history, etc.
[ Registered users of Control Hypertension and High Blood Pressure Nutrition can purchase this program 
for $20. ]
info

23. NutriGenie Diabetes Meal Planner for Windows v. 4.4 ($59)
A most comprehensive diabetes management system. The program follows the American Diabetes 
Association's dietary guidelines and is an excellent companion to the ADA publications. In addition to the 
sophisticated NutriGenie technology and unique USDA Food Pyramid analysis, this product implements 
the ADA Food Exchange System for meal planning. It will save hours and hours of tedious meal planning 
for diabetics: the program can automatically generate meals according to user's exchange requirements 
and food selections.
This package includes 2 other programs: Sugar Content of Foods and Omega-3 Counter and has utilities 
to keep track of blood glucose, blood pressure as well as weight log and diet history, etc.
[ Registered users of Control Diabetes version 1.2 can purchase this program for $35. ]
[ Registered users of Diabetic Nutrition version 3.3 can purchase this program for $25. ]
[ Registered users of Managing Diabetes version 3.6 can purchase this program for $15. ]
info

22. NutriGenie American Heart Diet for Windows v. 4.3 ($39)
The most effective dietary strategy to lose weight, lower cholesterol and reduce heart disease risk.
[ Registered users of Heart Perfect, Healthy Heart Nutrition and Lower Your Cholesterol can purchase this
program for $19. ]
[ Registered users of any of our other products can purchase this program for $29. ]
info



21. NutriGenie The Magical Dietitian for Windows v. 4.2 ($49)
Comprehensive nutrition software with NutriGenie technology and unique USDA Food Pyramid analysis. 
The program analyzes nearly 30 nutrients in your diet and has almost all utilities available in other 
NutriGenie products. This package includes Omega-3 Counter and is an essential tool for any health 
professionals.
[ Registered users of Compleat Nutritionist version 3.6 can purchase this program for $15. ]
[ Registered users of any program 1 to 15 above can purchase this program for $39. ]
info

20. NutriGenie Immune Deficiency Nutrition for Windows v. 4.2 ($49)
Award-winning nutrition software with sophisticated NutriGenie technology and unique USDA Food 
Pyramid analysis. Malnutrition depresses the immune system and makes infected people more 
susceptible to still other infections. A nutritious diet can enhance effectiveness of medical treatment, help 
restore immune function and reduce the severity of infectious disease complications. Based on the US 
Surgeon General's guidelines.
[ Registered users of The Compleat Nutritionist or Magical Dietitian can purchase this program for $15. ]
[ Registered users of any other programs listed above can purchase this program for $39. ]
info

19. NutriGenie Renal Diet for Windows v. 4.1 ($89)
Award-winning nutrition software with sophisticated NutriGenie technology and unique USDA Food 
Pyramid analysis. Based on the National Institutes of Health's and US Surgeon General's guidelines for 
nutritional therapy of end-stage renal disease (ESRD). Essential for health professionals in dietary 
management of renal failure.
info

18. NutriGenie Pregnancy Nutrition for Windows v. 4.1 ($39)
The program, developed from the findings of the American Academy of Pediatrics and the National 
Academy of Sciences, is the best nutrition software for a mother's health and that of her child. Has latest 
information on role of folate and zinc in pregnancy.
info

17. NutriGenie Fat to Fit for Windows v. 4.1 ($35)
Award-winning nutrition software with sophisticated NutriGenie technology and unique USDA Food 
Pyramid analysis. Indispensable to anyone who wants to achieve a more desirable weight.
[ Registered users of Weight Perfect, Eat Well Weigh Less, Pyramid Weight Loss Diet can purchase this 
program for $10. ]
[ Registered users of any other programs listed above can purchase this program for $25. ]
info

16. NutriGenie Calorie Counter for Windows v. 4.1 ($19)
Award-winning nutrition software with sophisticated NutriGenie technology and unique USDA Food 
Pyramid analysis.
info

15. NutriGenie Fat Counter for Windows v. 4.1 ($21)
Award-winning nutrition software with sophisticated NutriGenie technology and unique USDA Food 
Pyramid analysis. Most convenient for fat tracking in your diet.
info

14. NutriGenie Fat, Cholesterol and Sodium Counter v. 4.1 ($21)
Award-winning nutrition software with sophisticated NutriGenie technology and unique USDA Food 
Pyramid analysis. Most convenient for fat tracking in your diet.
info



13. Nutrition for Peak Performance for Windows v. 3.6 ($39)
Health is more than not being sick: it's being able to perform at your peak potential day in and day out. 
This program analyzes your diet for optimal intake of nutrients that have been shown to directly affect 
one's mental and physical capabilities. Ideal for students, athletes, and any professionals whose 
responsibilities demand the best from them.
info

12. Managing Diabetes for Windows v. 3.6 ($59)
The program implements the American Diabetes Association's dietary guidelines and is an excellent 
companion to the ADA publications. This package includes 2 other programs: Sugar Content of Foods 
and Omega-3 Counter and has utilities to keep track of blood glucose, blood pressure as well as weight 
log and diet history which do not exist in Diabetic Nutrition version 3.3. This product has been replaced by
NutriGenie Diabetes Meal Planner, however, it is continued to be offered at a discount.
[ Registered users of Control Diabetes version 1.2 can purchase this program for $35. ]
[ Registered users of Diabetic Nutrition version 3.3 can purchase this program for $25. ]
info

11. Nutrition for Women for Windows v. 3.6 ($39)
A complete nutrition guide for women of all ages with emphasis on weight control and prevention of 
osteoporosis and iron-deficiency anemia.
info

10. Eat Well, Weigh Less for Windows v. 3.6 ($37)
The program helps you design nutritious and well-balanced meals to lose weight. Has large database of 
foods and new utilities such as weight log and diet tracker.
info

9. Omega-3 Counter for Windows v. 3.4 ($19)
Analysis of 250 foods with highest concentration of Omega-3. Also their fat and cholesterol data.
info

8. Pyramid Weight Loss Diet for Windows v. 3.4 ($29)
The program analyzes user's weight control diet for conformance with the USDA Food Guide Pyramid in 
addition to the National Research Council's RDAs. Has standard database of approximately 1,000 most 
commonly used food items.
info

7. Diabetic Nutrition for Windows v. 3.3 ($39)
Essential tool for accurate monitoring of diabetic diet. Includes sugar analysis of common foods and 
weight control planner.
[ Registered users of Control Diabetes version 1.2 can purchase this program for $19. ]
info

6. Sugar Content of Foods for Windows v. 3.3 ($19)
Analysis of over 500 foods for glucose, lactose, fructose, galactose, sucrose, maltose and other sugars.
info

5. High Blood Pressure Nutrition for Windows v. 3.2 ($39)
The program is based on the report of the Joint National Committee on Detection, Evaluation, and 
Treatment of High Blood Pressure. An excellent nondrug approach to treatment for and prevention of high
blood pressure. This product has been replaced by NutriGenie Lower High Blood Pressure, however, it is 
being offered at a discount.
info

4. Lower Your Cholesterol for Windows v. 3.2 ($39)
More than half of all adult Americans have a blood cholesterol level that is higher than desirable. This 



program helps you conform to the cholesterol-lowering dietary guidelines of the National Cholesterol 
Education Program and National Heart, Lung, and Blood Institute.
info

3. Reduce Cancer Risk for Windows v. 3.0 ($39)
Based on studies of the National Cancer Institute and US Surgeon General's dietary guidelines, this 
program can help you lower the risk of cancer from diet.
info

2. Weight Perfect for Windows v. 3.0 ($35)
Indispensable to anyone who wants to achieve a more desirable weight. Has large food database of 
approximately 10,000 items.
info

1. Fat and Cholesterol Counter for Windows v. 1.1 ($19)
This program is a perfect companion to American Heart Association's Fat and Cholesterol Counter, a 
guide for everyone who wants a more healthful diet.
info

Some of our products have been adapted to use a German food database:

1. Ernährung für Frauen for Windows v. 3.5 ($39)
2. Das optimale Gewicht for Windows v. 3.5 ($35)

See also
Order form
Order form (German products)
Where to obtain NutriGenie software for evaluation



Fat and Cholesterol Counter
Database: 1,000 items, no user's database support
Analyses: calories, total fat, saturated fat, cholesterol, sodium.
Features: caloric need and caloric expenditure calculators, small omega-3 and soluble fiber databases.



Pregnancy Nutrition
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, calcium, iron, folate, zinc.
Features: weight log, diet history, weight control planner, body mass index, caloric need and caloric 
expenditure calculators, childs caloric requirement, target heart rate calculator, caloric and nutrient 
distribution analyzer, search and sort capabilities. Plus NutriGenie auto menu generator and graphic Food
Pyramid analysis.



Reduce Cancer Risk
Database: 10,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, fiber, vitamin A, vitamin C, carotenes.
Features: weight control planner, caloric need and caloric expenditure calculators, caloric and nutrient 
distribution analyzer, search and sort capabilities.



Weight Perfect
Database: 10,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat.
Features: weight control planner, body mass index, caloric need and caloric expenditure calculators, 
caloric and nutrient distribution analyzer, search and sort capabilities.



Lower Your Cholesterol
Database: 10,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, saturated fat, cholesterol, fiber, mono-
unsaturated fat and polyunsaturated fat, CSI (cholesterol-saturated fat index).
Features: cholesterol profiler, weight control planner, body mass index, caloric need and caloric 
expenditure calculators, caloric and nutrient distribution analyzer, search and sort capabilities.



Diabetic Nutrition
Database: 10,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, cholesterol, sodium, fiber, potassium and 
calcium.
Features: cholesterol profiler, weight control planner, body mass index, caloric need and caloric 
expenditure calculators, caloric and nutrient distribution analyzer, search and sort capabilities.
Other: the program Sugar Contents of Foods is included in this product.



High Blood Pressure Nutrition
Database: 10,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, cholesterol, sodium, fiber, potassium and 
calcium.
Features: cholesterol profiler, weight control planner, body mass index, caloric need and caloric 
expenditure calculators, caloric and nutrient distribution analyzer, search and sort capabilities.



Omega-3 Counter
Database: 250 items
Analyses: total fat, saturated fat, omega-3, cholesterol.
Features: nutrient distribution analyzer, search and sort capabilities.



Sugar Contents of Foods
Database: 500 items
Analyses: galactose, glucose, fructose, lactose, sucrose, maltose, other sugars, total sugars.
Features: nutrient distribution analyzer, search and sort capabilities.



Pyramid Weight Loss Diet
Database: 1,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, USDA food pyramid conformance.
Features: weight control planner, body mass index, caloric need and caloric expenditure calculators, 
caloric and nutrient distribution analyzer, search and sort capabilities.



NutriGenie American Heart Diet
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, saturated fat, monounsaturated fat, 
polyunsaturated fat, cholesterol, sodium.
Features: weight log, diet history, blood pressure log, cholesterol profiler, weight control planner, body 
mass index, caloric need and caloric expenditure calculators, target heart rate calculator, caloric and 
nutrient distribution analyzer, personal food groups, hide and unhide foods, search and sort capabilities. 
Plus NutriGenie auto menu generator and graphic Food Pyramid analysis.
Release date: December 1995



Nutrition for Women
Database: 10,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, iron, calcium.
Features: weight control planner, body mass index, caloric need and caloric expenditure calculators, 
target heart rate calculator, weight log and diet history tracker, caloric and nutrient distribution analyzer, 
search and sort capabilities.



Eat Well, Weigh Less
Database: 10,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, saturated fat.
Features: weight control planner, body mass index, caloric need and caloric expenditure calculators, 
weight log, diet history tracker, target heart rate calculator, caloric and nutrient distribution analyzer, 
search and sort capabilities.



Nutrition for Peak Performance
Database: 10,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, vitamin A, vitamin B-6, vitamin B-12, vitamin C, 
riboflavin, thiamin, iron, magnesium, phosphorus, zinc.
Features: weight control planner, body mass index, caloric need and caloric expenditure calculators, 
weight log, diet history tracker, target heart rate calculator, caloric and nutrient distribution analyzer, 
search and sort capabilities.
Requirement: SVGA display mode (800 x 600 or better)



Nutritionist Office
Features: please see info on each program.



Managing Diabetes
Database: 10,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, cholesterol, sodium, fiber, potassium and 
calcium.
Features: blood glucose tracker, weight log, diet history, blood pressure log, cholesterol profiler, weight 
control planner, body mass index, caloric need and caloric expenditure calculators, target heart rate 
calculator, caloric and nutrient distribution analyzer, search and sort capabilities.
Other: the programs Sugar Content of Foods and Omega-3 Counter are included in this package. 



NutriGenie The Magical Dietitian
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, saturated fat, monounsaturated fat, 
polyunsaturated fat, cholesterol, fiber, vitamin A, vitamin E, vitamin C, thiamin, riboflavin, niacin, vitamin 
B6, folate, vitamin B12, calcium, phosphorus, magnesium, iron, zinc, copper, sodium, potassium, alcohol.
Features: blood glucose tracker, weight log, diet history, blood pressure log, cholesterol profiler, weight 
control planner, body mass index, caloric need and caloric expenditure calculators, target heart rate 
calculator, caloric and nutrient distribution analyzer, search and sort capabilities. Plus NutriGenie auto 
menu generator and graphic Food Pyramid analysis.
Other: the program Omega-3 Counter is included in this package.



NutriGenie Calorie Counter
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat.
Features: caloric need calculator, caloric and nutrient preference specifier, search and sort capabilities. 
Plus NutriGenie auto menu generator and graphic Food Pyramid analysis.



NutriGenie Fat Counter
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, saturated fat, monounsaturated fat, 
polyunsaturated fat.
Features: caloric need calculator, caloric and nutrient preference specifier, search and sort capabilities. 
Plus NutriGenie auto menu generator and graphic Food Pyramid analysis.



NutriGenie Fat, Cholesterol and Sodium Counter
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, saturated fat, cholesterol, sodium.
Features: caloric need calculator, caloric and nutrient preference specifier, search and sort capabilities. 
Plus NutriGenie auto menu generator and graphic Food Pyramid analysis.



NutriGenie Fat to Fit
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat.
Features: weight log, diet history, weight control planner, body mass index, caloric need and caloric 
expenditure calculators, target heart rate calculator, caloric and nutrient distribution analyzer, search and 
sort capabilities. Plus NutriGenie auto menu generator and graphic Food Pyramid analysis.



NutriGenie Renal Diet
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, calcium, phosphorus, sodium, potassium, water.
Features: weight log, diet history, blood pressure log, cholesterol profiler, glomerular filtration rate (GFR) 
tracker, weight control planner, body mass index, caloric need and caloric expenditure calculators, target 
heart rate calculator, caloric and nutrient distribution analyzer, search and sort capabilities. Plus 
NutriGenie auto menu generator and graphic Food Pyramid analysis.
Other: the program Omega-3 Counter is included in this package.



NutriGenie Immune Deficiency Nutrition
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, saturated fat, monounsaturated fat, 
polyunsaturated fat, cholesterol, fiber, vitamin A, vitamin E, vitamin C, thiamin, riboflavin, niacin, vitamin 
B6, folate, vitamin B12, calcium, phosphorus, magnesium, iron, zinc, copper, sodium, potassium, alcohol.
Features: weight log, diet history, blood pressure log, cholesterol profiler, weight control planner, body 
mass index, caloric need and caloric expenditure calculators, target heart rate calculator, caloric and 
nutrient distribution analyzer, search and sort capabilities. Plus NutriGenie auto menu generator and 
graphic Food Pyramid analysis.



Diabetes Meal Planner
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, cholesterol, sodium, fiber, potassium, calcium, 
food pyramid.
Features: blood glucose tracker, weight log, diet history, blood pressure log, cholesterol profiler, weight 
control planner, body mass index, caloric need and caloric expenditure calculators, target heart rate 
calculator, caloric and nutrient distribution analyzer, search and sort capabilities. Plus NutriGenie auto 
menu generator, graphic Food Pyramid analysis. And implementation of the ADA Food Exchange System
for meal planning.
Other: the programs Sugar Content of Foods and Omega-3 Counter are included in this package.
Release date: January 1996



Lower High Blood Pressure
Database: 8,000 items plus user's own food database
Analyses: RDA, calories, protein, carbohydrate, total fat, cholesterol, sodium, fiber, potassium, calcium, 
food pyramid, K Factor.
Features: weight log, diet history, blood pressure log, cholesterol profiler, weight control planner, body 
mass index, caloric need and caloric expenditure calculators, target heart rate calculator, caloric and 
nutrient distribution analyzer, search and sort capabilities. Plus NutriGenie auto menu generator, graphic 
Food Pyramid analysis. And implementation of the ADA Food Exchange System for meal planning.
Other: the program Omega-3 Counter is included in this package.
Release date: January 1996



Registration Form
[This form can be printed by selecting 'Print' or 'Print topic' from the File pull-down menu.]

Please indicate which software product(s):

1. NutriGenie Pregnancy Nutrition for Windows v. 4.1 $39
2. NutriGenie Fat to Fit for Windows v. 4.1 $35
3. NutriGenie Calorie Counter for Windows v. 4.1 $19
4. NutriGenie Fat Counter for Windows v. 4.1 $21
5. NutriGenie Fat, Cholesterol and Sodium Counter v. 4.1 $21
6. NutriGenie Renal Diet for Windows v. 4.1 $89
7. NutriGenie Immune Deficiency Nutrition for Windows v. 4.2 $49
8. NutriGenie The Magical Dietitian for Windows v. 4.2 $49
9. NutriGenie American Heart Diet for Windows v. 4.3 $39
10. NutriGenie Diabetes Meal Planner for Windows v. 4.4 $59
11. NutriGenie Lower High Blood Pressure for Windows v. 4.4 $49

How did you obtain this shareware?

Name:

Address:

City: State: Zip:

NutriGenie accepts MasterCard, Visa and American Express payment. Holder of other credit cards, 
please use PsL Registration Service.

Credit card number: Expiration date:

Signature:

Telephone or email address:

Or please send check or money order to
NutriSoft

P.O. Box 8226
Stanford, CA 94309

International order: please remit in U.S. currency and add $2 for airmail postage. Because of high 
processing fee from our bank, we can no longer accept personal check from a non-US bank. Please use
credit card, money order from your bank, local American Express office, or postal money order. 
CompuServe users should use the CIS Shareware Registration Service.

Visit our WWW page http://pages.prodigy.com/CA/nutrigenie for latest registration information and 
discount offers.

See also 
Special Offer:   Registration for earlier programs  
German edition registration



Registration by Credit Card



Registration via CompuServe

Members of CompuServe can register for any NutriGenie products through its Shareware Registration 
Service (GO SWREG).

Please search for our products using "NutriGenie" as keyword or 71563,124 as contributor. You can also 
specify a particular filename if the search fails to list all of our software products. If for any reason, your 
search fails to list the desired products, please send an email message to 71563,124 for direction.

After you complete the CompuServe registration process, we will be notified and the upgraded registered 
software diskette(s) will be sent to you by airmail (international addresses) or first-class mail (U.S. 
addresses).

Visit our WWW page http://pages.prodigy.com/CA/nutrigenie for latest registration information and 
discount offers.

See also 
Special Offer:   Registration for earlier programs  
Registration by Credit Card



Registration by credit card

[This page can be printed by selecting 'Print topic' from the File pull-down menu.]

Credit card users can register for any NutriGenie products through the PsL (Public software Library) 
Registration Service. There is a PsL $2 handling fee for each item ordered: a product priced at $39 will 
cost you $41, for example; however, you save time and postage by taking advantage of this service. It is 
cheapest to order directly from NutriGenie using check, money order, MasterCard, Visa or American 
Express (credit card users can also order by email). Please visit our WWW page 
http://pages.prodigy.com/CA/nutrigenie for latest registration information and discount offers. In 
addition, if you wish to receive the 20% discount when ordering 3 or more items, you will need to register 
directly with NutriGenie. Neither PsL nor CompuServe can process this discount. The $2 airmail 
surcharge (for international order only) applies whether you register through PsL, CompuServe, or directly
with NutriGenie.

Please call 1 - 800 - 2424 - PsL ( 1-800-242-4775 ) or 713-524-6394 
[Monday - Thursday: 7am to 6pm CST, Friday: 7am to 12:30pm CST]

PsL Registration Service can also be reached
by FAX (713) 524-6398
by CIS Email 71355,470
by Internet Email 71355.470@compuserve.com
by mail P.O.Box 35705, Houston, TX 77235-5705.

Please note the above phone numbers and addresses are for registration by credit card only. Any 
questions about the status of the shipment of the order, product details, technical support, volume 
discounts, dealer pricing, site licenses, etc., must be directed to NutriGenie. You get quickest answers by 
sending email directly to NutriGenie.

To insure that you get the latest version, PsL will notify NutriGenie the day of your order and NutriGenie 
will ship the product directly to you.

List of NutriGenie products that can be registered through the PsL Registration Service:
(please mention the number preceding the program name: its PsL registration ID)

11551 Fat and Cholesterol Counter for Windows v. 1.1 ($21)

11553 Weight Perfect for Windows v. 3.0 ($37)

11554 NutriGenie Pregnancy Nutrition for Windows v. 4.1 ($41)

11690 Healthy Heart Nutrition for Windows v. 3.5 ($37)

11557 Reduce Cancer Risk for Windows v. 3.0 ($41)

11558 Lower Your Cholesterol for Windows v. 3.2 ($41)

11582 High Blood Pressure Nutrition for Windows v. 3.2 ($41)

11583 Diabetic Nutrition for Windows v. 3.3 ($41)

11689 Pyramid Weight Loss Diet for Windows v. 3.4 ($31)

11755 Nutrition for Women for Windows v. 3.6 ($41)



11883 Eat Well, Weigh Less for Windows v. 3.6 ($39)

11884 Omega-3 Counter for Windows v. 3.4 ($21)

11923 Nutrition for Peak Performance for Windows v. 3.6 ($41)

11924 The Compleat Nutritionist for Windows v. 3.6 ($51)

11948 Managing Diabetes for Windows v. 3.6 ($61)

14119 NutriGenie The Magical Dietitian for Windows v. 4.2 ($51)

14155 NutriGenie Fat to Fit for Windows v. 4.1 ($37)

14222 NutriGenie Calorie Counter for Windows v. 4.1 ($21)

14224 NutriGenie Fat Counter for Windows v. 4.1 ($23)

14251 NutriGenie Fat, Cholesterol and Sodium Counter v. 4.1 ($23)

14268 NutriGenie Renal Diet for Windows v. 4.1 ($91)

14300 NutriGenie Immune Deficiency Nutrition for Windows v. 4.2 ($51)

14343 NutriGenie American Heart Diet for Windows v. 4.3 ($41)

14367 NutriGenie Diabetes Meal Planner for Windows v. 4.4 ($61)

14387 NutriGenie Lower High Blood Pressure for Windows v. 4.4 ($51)

See also 
Special Offer:   Registration for earlier programs  
German edition registration
Registration via CompuServe



Registration form - German products
[This page can be printed by selecting 'Print topic' from the File pull-down menu.]

The following NutriGenie products are available in the German edition which uses a German food 
database. [ This database has approximately 1.000 food items, however, we regularly update and enlarge
our food databases and will send you the latest available data. ] Currently these items can be registered 
only directly with NutriGenie or through the CompuServe Shareware Registration service. Please indicate 
which software product(s):

1. Ernährung für Frauen for Windows v. 3.5 $39
2. Das optimale Gewicht for Windows v. 3.5 $35

Name:

Address:

City: State: Postal Code:

How did you obtain this NutriGenie 
shareware?

_______________________________

                                                           
Your email address, if available: _______________________________

NutriGenie accepts MasterCard, Visa and American Express payment. Holder of other credit cards, 
please use PsL Registration Service.

Credit card number: Expiration date:

Signature:

Telephone or email address:

Or please send money order to

NutriGenie
P.O. Box 8226

Stanford, CA 94309



SPECIAL OFFER: Registration for Earlier Programs
[This form can be printed by selecting 'Print topic' from the File pull-down menu.]

Although NutriGenie continually updates our programs, we still offer earlier versions of our products to 
users when they 

· don't need the new features in later products or 
· are interested in different food databases or
· would like to economize.

Special offer: Deduct up to $10 from each product having version number 3.6 or earlier. Please note, 
none of the following programs has the NutriGenie auto-menu generator technology, and only one (item 
9) has the graphic USDA Pyramid Food Guide analysis. All of our programs version 4.0 or later have 
these 2 unique features. To upgrade to 4.x software, you pay just the price difference plus $8 shipping 
and handling fee.
This offer is extended only to users who register directly with NutriGenie. Neither CompuServe nor PsL 
(Public Software Library) can process this special discount or other upgrade orders.
Please indicate which software product(s):

Program name version database originally you pay
1. Fat and Cholesterol Counter for Windows v. 1.1 1,000 $19 $15
2. Diabetic Nutrition for Windows v. 3.3 10,000 $39 $29
3. Weight Perfect for Windows v. 3.0 10,000 $35 $25
4. Pregnancy Nutrition for Windows v. 2.1 1,000 $39 $29
5. High Blood Pressure Nutrition for Windows v. 3.3 10,000 $39 $29
6. Healthy Heart Nutrition for Windows v. 3.5 1,000 $35 $25
7. Reduce Cancer Risk for Windows v. 3.0 10,000 $39 $29
8. Lower Your Cholesterol for Windows v. 3.2 10,000 $39 $29
9. Pyramid Weight Loss Diet for Windows v. 3.4 1,000 $29 $19
10. Omega-3 Counter for Windows v. 3.4 250 $19 $15
11. Nutrition for Women for Windows v. 3.6 10,000 $39 $29
12. Eat Well, Weigh Less for Windows v. 3.6 10,000 $37 $27
13. Sugar Contents of Foods for Windows v. 3.3 500 $19 $15
14. Nutrition for Peak Performance for Windows v. 3.6 10,000 $39 $29
15. The Compleat Nutritionist for Windows v. 3.6 10,000 $49 $39
16. Managing Diabetes for Windows v. 3.6 10,000 $59 $49

Name:

Address:

City: State: Zip:

How did you obtain this NutriGenie 
shareware?

_______________________________

NutriGenie accepts MasterCard, Visa and Amercan Express payment. Holder of other credit cards, 
please use PsL Registration Service.

Credit card number: Expiration date:

Signature:

Telephone or email address:

Or please send check or money order to



NutriGenie
P.O. Box 8226

Stanford, CA 94309

International order: please remit in U.S. currency and add $2 for airmail postage. Because of high 
processing fee from our bank, we can no longer accept personal check from a non-US bank. Please use
credit card, money order from your bank, local American Express office, or postal money order. 
CompuServe users can use the CIS Shareware Registration Service.

See also 
German edition registration
Registration by Credit Card



Determining Activity Levels

The activity levels used in NutriGenie programs range from 1 to 10. 

Level 1 corresponds to the resting state with little or no activity.

Levels 2 to 4 corresponds to a sedentary lifestyle where a 150-lbs individual would burn between 80 and 
150 Calories an hour. Please refer to the Caloric Expenditure dialog box. Users who do mostly office 
work, light housework, or driving, etc., belong to this category.

Levels 5 to 7 are for those with moderately active lifestyle. If you are an office worker but play tennis or 
bike ride an hour or 2 a day; or your profession demands physical activities similar to those of carpenters, 
plasterers, etc. then you belong to this category.

Levels 8 to 10 are for very active individuals such as athletes, those who regularly do strenuous tasks 
such as shoveling, weight lifting, etc.



Cholesterol Profile

This utility compares your cholesterol levels (total cholesterol, LDL cholesterol, HDL cholesterol and 
triglyceride) with those of the general population. There are 4 bars in each graph, the first bar indicates 
the lowest quartile (the lowest 25% of the population have cholesterol below this value), the second bar is
the average value of the population, the third bar shows the highest quartile (the top 25% of the 
population have their cholesterol level above this value) and the last bar is your own level.

Select your age group, your sex and use the spin controls to set your own cholesterol levels. The utility 
will adjust the graphs and indicate whether your level of a particular cholesterol is desirable, borderline 
high, or high, etc. These categories are defined by the National Institutes of Health's Adult Treatment 
Panel. Sometimes, LDL cholesterol is not measured directly in your test. In this case, you can tell the 
utility to estimate your LDL cholesterol from your total cholesterol, HDL cholesterol and triglyceride.

Your heart disease risk is categorized based on the ratio of your total cholesterol over your HDL 
cholesterol.

The 'Save' button will close the dialog and saves your personal values for future retrieval.



 NutriGenie "Lower High Blood Pressure" Help Index

General Information
            Introduction
            About "Lower High Blood Pressure"

Basic Operations
            NutriGenie Technology
            USDA Pyramid Food Guide Analysis
            ADA Food Exchange System
            Dietary Guidelines
            Main Uses of "Lower High Blood Pressure"
            How To Lose Weight
            How To Choose Diet Software

NutriGenie food databases
Edit user's food database
Create personal food groups
Program's icons and buttons [Please read this topic.]

            Dialog boxes
            New Features

Glossary
Top Tips
Frequently Asked Questions
About NutriGenie

Registration
Registration Form
Registration via CompuServe
Registration using credit card
Registration - German products
Disclaimer

Commands
File menu
View menu
Tools menu
Options menu
Window menu
Help menu

You can obtain specific help for the current task by pressing F1 at any window or dialog box.
To obtain a hard-copy of a help topic, choose 'Print topic' from the File pull-down menu.



Program's Icons and Buttons

This is a list of some common shortcuts via icons and buttons to all NutriGenie utilities, some icons may 
not be accessible in this program because their utilities are not available. If an icon is not described in this
list, you can obtain its description via the context-sensitive help button (the last button) on the application 
toolbar.

NutriGenie auto menu generator:

instructs NutriGenie to generate a well-balanced daily menu at your specified caloric intake level. (Use 
'Set NutriGenie Options ...' to specify the caloric requirement.)

instructs NutriGenie to generate a daily menu according to your food exchange requirement. (Use 'Set 
Exchange Options ...' to specify the exchange requirement.)

USDA Pyramid analysis:

brings up a dialog box which uses the USDA Food Guide Pyramid to analyze your diet.

Fat content:

indicates food item does not exceed user-specified percentage of calories from fat.

indicates food item exceeds user-specified percentage of calories from fat.

Click on either of these icons to specify the fat percentage where you want to be warned when exceeded.

Caloric analysis:

clicks this icon to see graphic analysis of calories from fat, protein and carbohydrate for selected food 
item.

Sorting:
Nutrients are sorted based on values in 100g of food.

clicks this icon to sort the items in the listbox in ascending order.

clicks this icon to sort the food items in descending order.



indicates the food items are sorted in ascending order, click on a food item in the listbox to see the 
nutrient's value.

indicates the food items are sorted in descending order.

Food groups viewing:
Since there can be more than 50 food groups in our database and an average screen can display only 
about 30 food groups at a time, these buttons make it more convenient to view the food groups (when you
hold down the mouse on the drop down listbox) by displaying them in normal order (first group first) or 
reverse order (last group first). You can select a food group by the mouse or by typing in the first letter of 
the food group's name.

displays food groups in normal order in drop down list box. Instead of clicking on this icon, you can use 
alt-n (Normal).

displays food groups in reverse order in drop down list box. Instead of clicking on this icon, you can use 
alt-r (Reverse).

indicates food groups are displayed in normal order.

indicates food groups are displayed in reverse order.

Searching:
Since there can be up to approximately 10,000 food items in our food database in addition to other items 
in user's database, this search facility makes it easy for you to locate any particular food by name. [Some 
of our programs come with a standard database of about 1,000 food items. Please see the readme.txt file 
for the database size of a particular program.] You can do a global or a local search. You can specify that 
the result include or exclude certain food items. 
Example: to find all foods containing 'yogurt', you type this string (without the quotes) into the edit control 
and click the global search icon. [If you don't see the search icons, you need to select Options then 
Search mode from the main menu first.] The result is displayed in the listbox below when the search is 
completed. To exclude all vanilla yogurt, you type the string '!vanilla' (without the quotes) into the edit 
control and click the local search icon. [Don't leave a space before your search text or after the 
exclamation point because blank space is significant in the search.] To narrow the result further, you can 
do another local search on the non-vanilla yogurt items; or you can proceed to another global search.

Enter search mode

Global search: searches both the NutriGenie and user databases for a food item containing or not 
containing a text string. You can use alt-g (Global) instead of clicking on this icon.



Local search: searches only the listbox's content for food items containing or not containing a text string. 
This is convenient for pruning down a previous search result which might contains hundreds of food 
items. You can use alt-l (Local) instead of clicking on this icon.

Quick Find:
If your current day's diet is too high in fat, for example, you can use this feature to quickly locate the item 
most contribute to this problem and adjust your consumption accordingly.

locates the food item in the current day's consumption that has the highest content of a particular nutrient.

locates the food item in the current day's consumption that has the lowest content of a particular nutrient.



View menu commands

The View menu offers the following commands:

Caloric Analysis Shows graphic analysis of percentage of calories from protein, 
carbohydrate and fat.

Nutrient Analysis Shows graphic analysis of the individual nutrient contents from your
daily food consumption.

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Tools menu commands

The Tools menu offers the following commands:

Cholesterol Profile Analyze your blood cholesterol levels and your heart disease risk
Weight Control Plan Use this dialog box to set short and long-term plan for weight 

control.
Desirable Weight Determine your ideal weight based on your sex, height and body 

frame.
Body Mass Index Compare your body mass index with the general population's
Caloric Need Find out your daily caloric need.
Caloric Expenditure Find out how much energy is used in common activities



Options menu commands

The Options menu offers the following commands:

Search Mode Allow you to search for any specific food from the 
standard and personal food databases.

Food Groups Mode Display food items according to food groups.
Personal Food Database Display food items from your personal food 

database.
Show CSI Toggle the display of Cholesterol Saturated Fat 

Index
Reverse Food Groups Reverse the display order of food group names
Choose Printer Font Select your favorite printer font for your nutritional 

and weight planning report.
Choose Screen    Color Select your favorite color for your screen 

background.
Set Nutrient Intake Preference Set your preferred ranges of nutrient intakes. The 

color of the RDA analysis bars will reflect your 
preference.

Set Fat Warning Level Set threshold beyond which you are alerted when 
a food item has more than certain percentage of 
calories from fat.

Left Mouse Button Quick Input Toggle the use of left mouse button for quick 
serving input

Right Button: Gram Quick Input 
Mode

Hold down the right mouse button on the window 
background will display serving amount in grams 
for quick selection.

Right Button: Ounce Quick Input 
Mode

Hold down the right mouse button on the window 
background will display serving amount in ounces
for quick selection.

Right Button: Serving Quick 
Input Mode

Hold down the right mouse button on the window 
background will display common serving sizes for 
quick selection.



Obesity

Excess weight or overweight occurs when too few calories are expended and too many consumed for 
individual metabolic requirements. If you eat more than you need, the surplus energy is stored in your 
body as fat. When the amount of your body fat is excessive and unsightly, you are overweight. More 
specifically, if your weight exceeds the desirable weight by 20% or more, you are considered obese. The 
extraordinarily high prevalence of obesity in the United States -- one-fourth of American adults are 
overweight and nearly one-tenth are severely overweight -- coupled with its role as a risk factor for 
diabetes, hypertension, coronary artery disease and stroke, gallbladder disease, and some types of 
cancer, suggests that a reduction in the average weight of the general population would improve the 
Nation's health. 

Americans, in general, would benefit from a lifestyle that includes more physical activity and a diet 
containing fewer calories and less fat.

Treatment of Obesity

If you wish to grow thinner, diminish your dinner,
And take to light claret instead of pale ale;

Look down with an utter contempt upon butter,
And never touch bread till it's toasted--or stale

H. S. Leigh (1837-83), English author. A Day for Wishing.

To lose weight, one must decrease caloric intake, increase caloric expenditure, or do both. Thus, the chief
approaches to weight reduction involve behavior change related to diet and exercise, drugs to decrease 
hunger or increase satiety, and surgical or mechanical intervention designed to reduce food intake.

Thus far, no drug therapy has induced long-term weight loss. Drugs are aimed at decreasing hunger or 
increasing satiety, usually by mimicking certain neurotransmitters or hormones that play a physiologic role
in feeding behavior. One problem is that weight lost with drug therapy is more often regained than with 
other methods, suggesting that appetite-suppressant drugs lower the set point level at which body weight 
is regulated and only secondarily suppress appetite. Regardless, weight loss would be expected to occur 
only during the period of drug therapy, suggesting the need for chronic treatment.

Surgical intervention appears appropriate only for selected persons with massive obesity or with its 
severe complications who have not responded to more conservative treatment. Jejunoileal bypass has 
been largely abandoned because of unfavorable side effects. Other procedures such as gastric balloons 
and gastric surgery, which reportedly cause substantial weight loss -- although rarely to ideal weight -- in 
morbidly obese persons, require further study before their long-term effects are known.

Weight loss reduces health risks in the obese. A combination of diet and exercise seems to be the most 
sensible approach to treatment. However, fad weight loss regimens of unscientific merit have been 
estimated, in 1981, to cost consumers $5 billion annually. While such diets attract many people's attention
they may be dangerous, especially when they provide less than the full complement of essential nutrients.

NutriGenie program is based on the US Surgeon General's Report on Nutrition and Health and dietary 
guidelines for weight reduction and prevention of obesity. It is an excellent tool to help you analyze your 
food intake and obtain a more desirable weight. This program allows you to enjoy varied, balanced, 
flexible, healthful and pleasant meals while you are on a weight loss diet. The program can be used by 
itself, or in conjunction with diet programs from your favorite authors. Whether you are vegetarian, or 
follow a macrobiotic diet, or enroll in a weight-loss club, etc., you will find that our software gives you 
better insight into your diet and helps you make informed dietary decisions.

"Four of the six leading causes of death



-- diabetes, heart disease, cancer and obesity -- are related to nutrition        
... [but] many doctors don't ask questions about diet    
until the patient has a heart attack."    
Dr. Steve Zeisel,        
Chairman, Nutrition Department, University of North Carolina
(Associated Press)



Dietary guidelines for weight control:

· To lose weight, one must decrease caloric intake, increase caloric expenditure, or do both.

· Because fat contains more than twice the caloric value per gram of either protein or carbohydrate,
the general public would benefit from reduced fat intake. The Food and Nutrition Board's Committee on 
Diet and Health recommended that the fat content of the U.S. diet not exceed 30% of caloric intake. Our 
software calculates and displays graphic analysis of fat content for every food entry (approximately 
10,000 items in our professional database and also those from user's database) as well as for your daily 
food consumption. The program also lets you set a fat warning level to easily identify high-fat foods: when
the specified percentage of energy from fat is exceeded, a red icon is displayed and associated with a 
food item.

· Sugar and alcohol provide calories from carbohydrate but no other nutrients, individuals seeking 
to attain and maintain desirable body weight should use these substances sparingly. Our program 
separates these items into their own food groups for easy identification and avoidance.

· In addition, extremely low calorie diets (300 to 400 kcal per day) should be avoided because it 
may be difficult to meet essential vitamin and mineral requirements on low-calorie diets. Crash diets 
seldom work if your objective is to lose weight permanently. First, when the weight you lose is mostly 
body water, it will come back when you return to your normal routines. Second, severely restrictive diets 
are not sustainable for most people on a long-term basis. Our software helps you identify inadequate 
diets. It also helps you design those that are healthy, varied and balanced because the program lets you 
choose wisely from thousands of foods.

· Evidence indicates that exercise burns calories, increases the proportion of lean to fat body 
mass, and, therefore, raises the metabolic rate. Increased levels of physical activity are important for 
attaining desirable body weights among the general population. The rule regarding exercising is to go 
slow and steady. Our software provides a convenient utility to help you determine how much energy you 
expend through common activities and exercises. As a result, you can identify those activities that may be
ineffective or those that are too strenuous. In consultation with your physician, you can devise an exercise
program that is suitable to your physical condition.

· When you design a diet for yourself, make sure that it is varied and balanced. [You can use the 
Food Pyramid Analysis tool (available in our Pyramid Weight Loss Diet program and the NutriGenie 
series) to determine if your diet conforms with the USDA's Food Guide Pyramid.] In general, you should 
choose the foods that you like so long as they are low in fat. Diet doesn't mean deprivation. The one 
simple adjustment you most likely need to make is: reduce fat intake.

· It is better to have several small meals than few big ones. People who have large, infrequent 
meals tend to gain more weight than those who eat smaller quantities (but the same total) at regular 
intervals. Our graphic analysis allows you to inspect and distribute your nutrient intake evenly throughout 
the day as desired.

See also Obesity

Important:    The dietary guidelines contained in this program are derived from research published by US 
government agencies and by private non-profit health organizations. The nutritional guidelines in this 
section are for your information only. Before adopting any diet, please obtain approval from your 
physician.

 



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print Setup Selects a printer and printer connection.
Exit Exits program.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document (file) in "Reduce Cancer Risk". A document (file) contains all
the information regarding the foods you consume during a day. You can open an existing document with 
the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple documents at 
once.    Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... 
command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open.

Drives
Select the drive in which "Reduce Cancer Risk" stores the file that you want to open. 

Directories
Select the directory in which "Reduce Cancer Risk" stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    "Reduce Cancer Risk" suggests
that you save changes to your document before you close it.    If you close a document without saving, 
you lose all changes made since the last time you saved it.    Before closing an untitled document, 
"Reduce Cancer Risk" displays the Save As dialog box and suggests that you name and save the 
document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, "Reduce Cancer Risk" displays the Save As dialog box so you can name your 
document.    If you want to change the name and directory of an existing document before you save it, 
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    "Reduce Cancer Risk" displays the Save As 
dialog box so you can name your document.    

Important:
You should save all your files in the directory where you install "Reduce Cancer Risk". The Weigh Control 
planner will look for them in this directory.

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    "Reduce Cancer Risk" adds the extension 
you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Important:
You should save all your files in the directory where you install "Reduce Cancer Risk". The Weigh Control 
planner will look for them in this directory.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your "Reduce Cancer Risk" session.    You can also use the Close command on
the application Control menu.    "Reduce Cancer Risk" prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in "Reduce Cancer Risk", such as File Open.    A check mark appears next to the menu item 
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in "Reduce Cancer Risk",

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    "Reduce Cancer Risk" displays the Open dialog box, in which you 
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, "Reduce Cancer Risk" displays the Save As dialog box.

Print the active document.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the "Reduce Cancer Risk" window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

"Reduce Cancer Risk" displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose a document 
from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using "Reduce Cancer Risk" and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



Context Help command 

Use the Context Help command to obtain help on some portion of "Reduce Cancer Risk".    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.   
Then click somewhere in the "Reduce Cancer Risk" window, such as another Toolbar button.    The Help 
topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the "Reduce Cancer Risk" window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    "Reduce Cancer Risk" determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    "Reduce Cancer Risk" determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

Select your favorite font for printed report of nutritional analysis or weight control plan.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



Cholesterol-Saturated fat Index (CSI)

Foods high in cholesterol and saturated fat raise blood cholesterol level and increase the risk of heart 
attacks and strokes. To facilitate the direct comparison of foods, researchers have developed an index, 
the Cholesterol-Saturated Fat Index, which provides an easy way to compare foods. 
In general, the lower the CSI of a food item, the lower the risk it is to your health. The program displays 
the CSI value in dark blue if the food is relatively low in CSI and dark red otherwise. When your diet 
exceeds the recommended daily CSI value, the total CSI value for the day is also displayed in dark red. 

You can choose to show or not to show the CSI calculation by toggling the 'Show CSI' menu item under 
the Options pull-down menu.
This index is available in Lower Your Cholesterol only.

To obtain more information about CSI, please refer to 'The New American Diet System' by S. L. Connor 
and W. E. Connor, ISBN 0-671-68705-0.



Food Guide Pyramid

The Food Guide Pyramid was published by the United States Department of Agriculture 
(USDA) in 1992. This is a new approach for managing one's diet which replaces the older 
basic four (or five) food groups approach.

The new food groups are organized into the shape of a pyramid. The fundamental ideas 
behind the Food Guide Pyramid approach are: one should eat a variety of foods and more 
from the lower food groups than from the upper food groups which translates into "Choose a
diet with plenty of vegetables, fruits, and grain products."

Many nutrition programs do an excellent job in helping users keep track of their calorie 
consumption, fat intake, etc. NutriGenie programs provides an additional important 
feature: its users can quickly check to see if their diet conform to the USDA Food Guide 
Pyramid. Planning your weight loss diet this way is desirable because you can lose weight 
and, at the same time, adequately obtain the necessary nutrients through your balanced 
diet. You can achieve similar result using other programs and approaches, however, our 
graphic pyramid food analysis makes the process much simpler and enjoyable to use.

A Daily Food Guide
You need more than 40 different nutrients for good health. Essential nutrients include 
vitamins, minerals, etc. These nutrients should come from a variety of foods, not from a few 
highly fortified foods or supplements. Any food that supplies calories and nutrients can be 
part of a nutritious diet. The content of the total diet over a day or more is what counts.

No single food can supply all nutrients in the amount you need. For example, milk provides 
calcium but little iron; meat supplies iron but little calcium. To have a nutritious diet, you 
must eat a variety of foods. One way to assure variety--and with it, an enjoyable and 
nutritious diet--is to choose foods each day from the five major food groups described below.
Individuals who do not eat foods from one or more of the food groups may want to contact a 
dietitian for help in planning how to meet nutritional needs.

Most people should have at least the lower number of servings suggested from each food 
group. Some people may need more because of their body size and activity level. Those who
are on a weight loss diet should also have a variety of foods but will need fewer or smaller 
servings. They also need to eat less foods high in calories and low in essential nutrients, 
such as fats and oils, sugars, and alcoholic beverages.

Supplements of some nutrients taken regularly in large amounts can be harmful. Vitamin 
and mineral supplements at or below the Recommended Dietary Allowances (RDA) are safe, 
but are rarely needed if you eat a variety of foods.

Food Group Suggested servings
Fats and sweets Eat sparingly
Milk, yogurt and cheese 2 - 3 servings
Meats, poultry, fish, dry beans and peas,
eggs, and nuts 2 - 3 servings
Vegetables 3 - 5 servings
Fruits 2 - 4 servings
Breads, cereals, rice, and pasta 6 - 11 servings

What counts as a serving?

The following table approximates what counts as a serving for each food group. NutriGenie 
analysis takes into account the precise nutrient contribution from each food and therefore 



generates more accurate serving calculation in our programs.

Group 1: Sweet
a. an ounce of hard candies
b. a medium bar of chocolate

Group 2: Milk
a. one cup of milk or yogurt
b. one and a half ounces of cheese

Group 3: Meat
a. two to three ounces of cooked meat, poultry or fish
b. half a cup of cooked dry beans counts as an ounce of meat or 1 serving of vegetables
c. one egg counts as an ounce of meat

Please note that in NutriGenie software, we assign half of the amount of cooked dry 
beans consumed to the meat group and the other half to the vegetable group. 

Group 4: Vegetable
a. one cup of raw leafy vegetables
b. half a cup of other vegetables, cooked or chopped raw
c. three quarters of a cup of vegetable juice

Group 5: Fruit
a. a medium apple or banana
b. three quarters of a cup of fruit juice
c. half a cup of sliced fruit

NutriGenie takes into account both the weight and nutrient contribution from a fruit.

Group 6: Cereal
a. a slice of bread
b. an ounce of ready-to-eat cereal
c. half a cup of rice or pasta

This guideline is expressed in the shape of a pyramid. The pyramid analysis of your diet 



should result in a well-balanced pyramid where the lower groups are wider than the upper 
groups. While you are on a weight loss diet, it may not matter significantly if you do not 
consume the same number of servings for each food group as recommended to an average 
individual. You may actually eat fewer servings; however, if your pyramid is balanced you 
will have a healthful, varied diet to help you lose weight safely. In any event, before adopting
any diet, you should discuss it with your physician and obtain his/her approval.

See also
The ADA Food Exchange System



NutriGenie Technology

Starting with version 4.0 of our software, we incorporate a unique technology into all of our 
nutrition software products: the NutriGenie technology. With this technology, the user can 
specify a daily caloric consumption level and instruct the program to automatically generate 
menus that are well-balanced and meet the desired caloric requirement.

The task of menu preparation can be quite tedious to health professionals who need to 
recommend different diets to a large number of people; or to individual users who have to 
follow certain restrictive diet but don't know what and how much they can eat.

NutriGenie technology removes this difficulty: with a click of a button
, a well-balanced menu is freshly created each time. None of the menus are pre-generated, 
and with a food database of approximately 8,000 items, users have literally millions of 
nutritious menus to choose from. [The menus generated for the shareware version are not 
as varied because of the much smaller shareware food database.]

The daily menus generated by NutriGenie, in almost all cases, are exactly at or within a few 
(+/- 10) Calories of the requested caloric level. In addition, with the occasional exceptions in 
highly restrictive diets (below 1000 Calories/day), the menus generated are well-balanced 

and conform with the USDA Food Pyramid guidelines. 

Please note that regardless of how balanced the NutriGenie menus are, if your caloric 
specification level is too low, you may not adequately obtain all necessary nutrients in your 
diet and may need to use supplements to satisfy their RDAs.
Please also pay special attention to the amount of each suggested food in the generated 
menus. We associate a standard unit with each food item, for example, '1 slice' with bread, 
'1 cup' with milk. These units are modified by a multiplier to indicate the recommended 
amount. E.g., Bread, 1 slice x 2 or Milk, 1 cup x .5. These mean 2 slices of bread and half a 
cup of milk, respectively.

Characteristics of NutriGenie Menus

The generated menus are intended to show you the large variety of foods that you can eat 
even when you are on a diet. The menus also illustrate what a well-balanced diet should look
like at different caloric intake levels.

In general, you don't have to deprive yourself of any particular food category so long as the 
amount you eat is appropriate for your optimal caloric consumption target. For example, 
even a low-calorie diet can include ice cream for dessert although the amount is more likely 
half a cup instead of a cup of ice cream. For this precise reason, occasionally, you will see 
suggested food amount as 1 cup x .7. This just means for the specified caloric intake, you 
should consume about 3 quarters of a cup of the food instead of one whole cup.

NutriGenie menus are suggestions, not rigid prescriptions. Although we use a standard food 
database appropriate for the US population, our database also contains a number of food 
products from other parts of the world. This reflects the diversity of the American population 
as well as the culinary sophistication of our users. So you will see fruits like kiwi or mango; 
cheese like Camembert or Gruyere; etc. on our suggested menus. Feel free to substitute 
them by comparable foods that are readily available in your area.

Another characteristic of NutriGenie generated menus is that they are biased towards 
offering choices to user. For example, a very high-calorie diet may very well have both a 



meat main dish and a fish main dish at dinner instead of just one main dish with a larger 
serving size. This allows the user to choose either to actually have both meat and fish or to 
keep his preferred dish, remove the other and adjust the serving size accordingly.

How to Use NutriGenie Menus for Weight Control

NutriGenie menus are perfectly suited for use with our Weight Control Planner utility. You can
use the Planner to determine the caloric intake level that maintains your current weight. If 
you desire to lose some weight, for example, you can tell NutriGenie to generate several 
menus at different lower caloric levels. Using these test menus in the Planner, you can find 
out the caloric intake level that helps you achieve your weight goal at the optimal rate. Once
this figure has been obtained, NutriGenie can generate a week's or month's worth of menus 
for you to review and edit. The printed copies of these menus are a most convenient tool for 
you to monitor your diet.

Similarly, if you wish to gain weight, you can use the Caloric Need utility to determine the 
caloric and nutrient requirements for your ideal weight and generate appropriate NutriGenie 
menus for monitoring.

Limitations: 

· NutriGenie auto-generated menus are intended for use by healthy individuals. If you
have special nutritional requirements, you will need to modify the generated menus so they 
can optimally satisfy your requirements.

· Currently, NutriGenie can only generate balanced menus based on user's caloric 
specification. It cannot generate menus based on any specific nutrient or combination of 
nutrients.

See also
Using Food Exchange System and the Automatic Menu Generator



VGA Display Mode

The diet analysis in some of our programs may include many more nutrients than can all be shown on the
VGA display. To enable these programs to run under VGA mode, we have implemented a feature that 
allows users to specify the several nutrients of most interest to them to be shown when these programs 
are run on machine without the SVGA (800 x 600 or higher) capability.



Choosing a Diet Program

"Combining exercise and a proper diet is the only healthy path to a lean body."
Dr. Jeffrey Friedman, Rockefeller University

Dr. Friedman's lab at Rockefeller University is credited 
as the first to produce the genetically obese mice

 which leads to the isolation of the protein leptin
 that controls production of body fat.

What to look for in a diet program?
Although there are many nutrition and diet software products on the market. Some of them 
may not be particularly useful. You may want to ask the following questions when choosing 
your software:

1. What kind of analyses does the software provide? Do they offer insight for good
dietary decision?
It's good to know that your diet has 19.4% calories from saturated fat; or that it exceeds the 
RDA for vitamin A by 27%. But statistics like these do not engender insight or good dietary 
decision. Most existing diet software can only generate raw numbers and simple charts.

NutriGenie software provides unique analyses such as the USDA Food Pyramid analysis 
where in one glance you can tell if your diet is varied and balanced (pure number of fat or 
protein grams in your diet can't tell you this). 
Besides showing you whether your diet satisfies the National Research Council's RDA, 
NutriGenie programs let you specify your own personal nutrient intake preferences and 
using intuitive color-coding let you quickly determine if your goals are met or exceeded.
Similarly, our automatic fat content analysis incorporates your own fat limit preference and 
the subtle color variation (from gray to white on the fat percentage indicator) alerts you 
when your threshold is exceeded.
In addition, the caloric and nutrient distribution in your diet throughout the day can be a 
factor that affects the efficiency of your metabolism and the absorption of nutrients. 
NutriGenie programs offer this important analysis.
As you can see, a good diet analysis is more than just some numbers and percentages. No 
existing diet software offers such comprehensive and insightful view of your diet as our 
NutriGenie series.

2. Is the software smart enough to help me in the tedious task of menu 
preparation?
One problem many dieters face is figuring out what and how much they can eat to achieve 
their weight goal. A common solution is to buy a diet book where a few limited menus are 
presented. 
Some meal-planning software products don't do much better than these books; the rest are 
simply incapable. As a result, dieters tend to choose from a small selection of foods making 
their eating experience unnecessarily boring while it should be truly enjoyable.

The NutriGenie series uses sophisticated techniques to generate nutritious and well-balanced meals 
for you. With a database of approximately 8,000 foods, NutriGenie can generate literally 
millions of menus that meet a wide range of caloric requirement: whether it's a 900- or 
2,345-calorie diet. The menus generated by NutriGenie are always within a few calories or 
your specification and are almost always well-balanced as seen through the USDA Food Guide
Pyramid analysis which is displayed immediately after the menu has been prepared.

Starting with version 4.4, NutriGenie incorporates the Food Exchange System into our 
programs. With this feature, our users have even more flexibility in meal planning: not only 
can they specify exactly how many and what exchanges they want to have at each meal, 



but they can also specify exactly what foods the program may use to generate their meals.

3. Does the software help me plan my weight loss?
It's hard to achieve one's weight goal without planning. But most diet and nutrition programs
are not planning tools. In fact, they are no more than log books: they only help you record 
what you eat and automate some simple calculations. 

NutriGenie programs are planning tool. With the Weight Control Planner utility, you can 
determine the caloric requirement to maintain your current weight; you can devise flexible 
diet cycles and test them; you can predict how much you will weigh a week or several 
months into the future. The what-if analysis capability and the detailed menus allow you to 
take concrete steps towards achieving your weight goal. When you just passively record 
what you've already eaten, the progress can be quite unpredictable.

4. How is the food database organized? Does it facilitate decision making?
Many nutrition programs arrange their foods in groups, some don't. Most provide some 
searching ability. Few go beyond this feature.

NutriGenie program organizes its food database in groups but also allows viewing the whole 
or partial food database by including or excluding foods based on user's specification.
Equally important, our program lets the user sort items within a food group, a partial or the 
whole food database.

Starting with version 4.3, user can create personal food groups as well as hide and unhide 
foods from NutriGenie database. These features make it even more convenient to access 
foods and browse the food database.

Organizing foods into food groups allows you to identify substitutes, presents alternatives 
which you may not be aware of. Sorting foods on different nutrients lets you make better 
food choices.
NutriGenie programs are for the educated users who want and can evaluate information to 
make informed decision.

5. Does the software provide relevant and useful tools?
Again, many diet programs don't do more than record keeping.

On the other hand, once you've selected your favorite exercise, NutriGenie automatically 
displays its caloric equivalence for each food item you eat thus showing vividly the 
relationship between exercise and diet.
NutriGenie software provides utilities to calculate your ideal weight, your caloric and nutrient
requirement and comes with an extensive exercise database. It calculates your target heart 
rate so you can get the most benefit out of exercising. Its body mass index (BMI) calculator 
matches your BMI against those in the general population and supplies statistics regarding 
health risk associated with your BMI such as mortality, heart disease, diabetes, etc. Some of 
our products have utilities for you to keep track of your cholesterol, blood pressure, etc. But 
more than just record keepers, your cholesterol and blood pressure levels are compared and 
contrasted with others' giving you insight which mere numbers don't.

6. Has the software received any legitimate recognition or award?
In June 1995, Home PC Magazine awarded our Pyramid Weight Loss Diet the prestigious 
Editors' Choice: Top 100 Products of the Year Award. We are the only nutrition 
software publisher ever to receive this distinction from a major publication. [The NutriGenie 
series contains all features in Pyramid Weight Loss Diet with significant enhancements such 
as a much larger food database and the auto menu-generator capability.]



Ziff-Davis Interactive has given our products the 5-star highest ratings and 

Noah Matthews, Knight-Ridder News Service columnist, wrote that our nutrition 
software are "the best."

Please download our shareware from CompuServe, America OnLine or various BBS and ftp 
sites for your own evaluation. Our Web sites http://pages.prodigy.com/CA/nutrigenie 
and http://home.aol.com/NutriSoft have the latest product information and evaluation 
software.



Does the software provide authoritative dietary guidelines?

How easy is it to adjust my meal plan? what if analysis
convenient data input: edit copy meal, identify bad/good foods, quick data entry

Fit in with your diet plan



Hide and Unhide Foods

Starting with version 4.3, foods in the standard NutriGenie database can be hidden and unhidden to allow
convenient browsing of the food database. You might want to hide all foods that you don't normally use to 
reduce the number of foods to scroll through in the food listbox. Foods that are hidden will not show up in 
a search.

Hide foods
There are 2 ways to hide foods:
1. one food at a time: select a food entry in the listbox under the NutriGenie food groups 
combobox. Then choose the 'hide food' menu item to hide this food. The food is 
automatically removed from the listbox and will not show up again.
2. a whole meal at a time: if there are NutriGenie foods in a meal, all of them can be hidden 
at your request. You can use any meal to accumulate all the foods you wish to hide and hide 
them all at the same time.

Show hidden foods
You can review the hidden food list and unhide any items you wish to restore.

Unhide food
You can unhide foods one item at a time. You must first show the hidden foods, then select the item you 
wish to restore to the database.

See also
Organizing foods using personal food groups or exchange groups
Organizing foods using meal groups



Personal Food Groups or Food Exchange Groups
Starting with version 4.3, users can create personal food groups to facilitate their accessing 
frequently used food items. In programs that incorporate the ADA Exchange System, 
the Personal Food Groups are replaced by the Food Exchange Groups and the 
Meal Groups. [ Please note that when a food item is assigned to an exchange groups, its 
serving size should be that of 1 exchange in this group.]

Adding foods to personal food groups
There are 2 ways to add foods to personal food groups:
1. one food at a time: select a food entry in the listbox under the NutriGenie food groups 
combobox. Then choose the 'add' menu item to add this food to desired food groups. A food 
can be added to more than one personal food groups.
2. a whole meal at a time: if there are NutriGenie foods in a meal, all of them will be added 
to the desired group at your request. You can use any meal to accumulate all the foods you 
wish to group together and add them all at once.

Showing foods in personal food groups
If a group contains at least 1 item, this command will be enabled.

Removing foods from a group
You can remove foods one item at a time. All the groups that an item belongs to are highlighted on the 
pulldown menu.

Review Food Lists Dialog
This dialog box provides a summary of food counts in exchange and meal groups. You can clear all food 
items from a list by clicking on the 'Clear' button.

See also
Hide and unhide foods
Assign foods to meal groups



Foods and Meals: What You Want to Eat When
Starting with version 4.4, users can assign foods to any of the 6 meal groups to facilitate 
their accessing frequently used food items at each meal. In programs that incorporate 
the ADA Exchange System, the Meal Groups are also used to generate menus 
using the foods the users want only when specified. [This means a particular food has
to be assigned to both an exchange group and to at least one meal group to be considered 
for selection when NutriGenie is asked to generate daily menus based on your exchange 
requirements.]

Adding foods to meal groups
There are 2 ways to add foods to a meal group:
1. one food at a time: select a food entry in the listbox under the NutriGenie food groups 
combobox. Then choose the 'add' menu item to add this food to desired meal groups. A food
can be added to more than one meal groups.
2. a whole meal at a time: if there are NutriGenie foods in a meal, all of them will be added 
to the desired group at your request. You can use any meal to accumulate all the foods you 
wish to group together and add them all at once.

Showing foods in meal groups
If a group contains at least 1 item, this command will be enabled.

Removing foods from a group
You can remove foods one item at a time. All the groups that an item belongs to are highlighted on the 
pulldown menu.

See also
Hide and unhide foods
Assign foods to exchange groups



Top Tips

1. Use F1 to bring up the help screen whenever you want more information about a window or dialog 
box.

2.
Use Search function to find foods Try both global and local searches as well as 'exclude' search 

(using !)

3. Use Mouse for quick food amount input Try both left and right mouse buttons, set them to different 
common quantities

4.
Use Find Max to locate food that causes excessive nutrient intake

5. Copy and paste meals

6.
Use NutriGenie Pyramid for suggestions of well-balanced daily menus that meet your caloric 

requirement

7.
Use NutriGenie Exchange for suggestions of daily menus that meet your exchange requirement and use

only the foods you selected

8.
Use Pyramid Analysis to see if your diet is well-balanced

9. Hide foods you don't use and copy frequently used foods to personal food groups or exchange 
groups



Lower Cholesterol Diet

The Recommended Treatment: A Blood Cholesterol Lowering Diet

Whatever the reasons may be for your high blood cholesterol level -- diet, heredity, or both -- the 
treatment your doctor will prescribe first is a diet. If your blood cholesterol level has not decreased 
sufficiently after carefully following the diet for 6 months, your doctor may consider adding cholesterol-
lowering medication to your dietary treatment. Remember, diet is a very essential step in the treatment of 
high blood cholesterol. Cholesterol-lowering medications are more effective when combined with diet. 
Thus medications are meant to supplement, not replace, a low-saturated fat, low-cholesterol diet.

What changes should you make in your diet?
Your new diet should be low in saturated fat and low in cholesterol and be adequate in all nutrients, 
including protein, carbohydrate, fat, vitamins, and minerals.

1. Eat less high-fat food
There are two major types of dietary fat: saturated and unsaturated. Unsaturated fats are further 
classified as either polyunsaturated or monounsaturated fats. Together, saturated and unsaturated 
fats equal total fat. All foods containing fat contain a mixture of these fats.
One of the goals in your blood cholesterol-lowering diet is to eat less total fat, because this is an 
effective way to eat less saturated fat. Because fat is the richest source of calories, this will also help 
reduce the number of calories you eat every day. If you are overweight, weight loss is another 
important step in lowering blood cholesterol levels. If you are not overweight, be sure to replace the 
fat calories by eating more food high in complex carbohydrates.

2. Eat less saturated fat
Saturated fat raises your blood cholesterol level more than anything else in your diet. The best way to
reduce your blood cholesterol level is to reduce the amount of saturated fat that you eat.
Animal products as a group are a major source of saturated fat in the average American diet. 

3. Substitute unsaturated fat for saturated fat
Unsaturated fat actually helps to lower cholesterol levels when it is substituted for saturated fat. 
Therefore, health professionals recommend that, when you do eat fats, unsaturated fats 
(polyunsaturated and monounsaturated fats) be substituted for part of the saturated fat whenever 
possible.

4. Eat less high-cholesterol food
Dietary cholesterol is a waxy, fat-like substance found in foods that come from animals. Although it is 
not the same as saturated fat, dietary cholesterol can also raise you blood cholesterol level. 
Therefore, it is important to eat less food that is high in cholesterol. While cholesterol is needed for 
normal body function, your liver makes enough for your body's needs so that you don't need to eat 
any cholesterol at all.

5. Substitute complex carbohydrates for saturated fat
Contrary to popular belief, high-carbohydrate foods (like pasta, rice, potatoes) are lower in calories 
than foods high in fat. In addition, they are good sources of vitamins and minerals. What adds calories
to these foods is the addition of butter, rich sauces, whole milk, or cream, which are high in fat, 
especially saturated fat. It is important not to add these to the high-carbohydrate foods you are 
substituting for foods high in fat.

In addition, you should:
6. Maintain a desirable weight

People who are overweight frequently have higher blood cholesterol levels than people of desirable 
weight. You can reduce your weight by eating fewer calories and by increasing your physical activity 
on a regular basis. Research has shown that on average, each 2 pounds of excess body fat 



contributes 1 mg/dl to your total blood cholesterol.

See also
How to Lose Weight

Important:    The dietary guidelines contained in this program are derived from research published by US 
government agencies and by private non-profit health organizations. The nutritional guidelines in this 
section are for your information only. Before adopting any diet, please obtain approval from your 
physician.



Dietary Guidelines for Diabetes

Role of Specific Dietary Factors in Diabetes

Calories
Caloric intake should be adequate to achieve and maintain a desirable weight. Obesity is 
strongly associated with the onset and severity of Type II diabetes. At least 80 percent of 
persons with the Type II disease are more than 15 percent in excess of their desirable weight
at the time of diagnosis. Some estimates suggest that new cases of this condition could be 
reduced by nearly half by preventing obesity in middle-aged adults.

Fat
The traditional restriction of carbohydrate intake in persons with diabetes leads to an 
increased fat intake (and, usually, saturated fat) because the percent of protein in human 
diets typically does not vary much. This high saturated fat consumption may have 
contributed to the frequent cardiovascular complications seen in past years among persons 
with diabetes. To help reduce this increased risk for coronary heart disease, a diet low in 
total fat, saturated fat, and cholesterol has been recommended (American Diabetes 
Association Task Force 1987). Fat intake should comprise 30 percent or less of total calories. 
Because dietary fat contains more than twice the calories of either protein or carbohydrate, 
a reduction in fat intake should lead to a more favorable caloric balance, especially when 
this dietary change is accompanied by appropriate levels of physical activity. Controlling 
obesity by reducing dietary fat intake should help reduce the prevalence of Type II diabetes 
and is also consistent with dietary recommendations for the prevention of coronary heart 
disease, hypertension, and some types of cancer.

Carbohydrates
A diet containing 50 to 60 percent of total calories as carbohydrate is now recommended for 
individuals with diabetes (American Diabetes Association Task Force 1987), not only because
high-carbohydrate diets improve glucose tolerance and insulin sensitivity, but also because 
the reduced fat--especially saturated fat--intake that accompanies a high-carbohydrate diet 
lowers cardiovascular risk.

One type of meal planning techniques used for diabetes management is carbohydrate 
counting. There are two basic types of carbohydrates: simple and complex. The simple 
carbohydrates are commonly called sugars. Starches and fiber are complex carbohydrates. 
Both sugars and starches are broken down by the body into glucose. The American Diabetes 
Association has determined that it is the total amount of carbohydrate you eat that is 
important and there is little evidence to support restricting sugar-containing foods. You can 
use NutriGenie software to monitor your carbohydrate consumption.

Protein
The protein requirements of individuals with diabetes under good control seem to be the 
same as those of healthy individuals; that is, a daily intake of 0.8 g/kg of body weight for 
adults and somewhat higher intakes for infants, children, and pregnant or lactating women 
(NRC 1980). When insulin levels are normal, protein is conserved in the body and the use of 
amino acids for glucose synthesis is limited. In persons with poorly controlled diabetes, 
dietary requirements may be increased because protein is used to synthesize glucose.

Individuals with diabetes and concurrent renal insufficiency should avoid excessive protein 
intake. Glomerular hyperfiltration (increased blood flow and filtration across the renal 
glomerular capillary bed) leads to impaired renal function in persons with diabetes, and 
increased protein intake may exacerbate renal damage. Furthermore, protein restriction 
slows the rate of decline in renal function in individuals with diabetic nephropathy. Because 
past dietary recommendations for persons with diabetes sometimes emphasized protein, 



and because the average American eats more protein than is necessary to maintain health, 
current recommendations suggest that people with diabetes should reduce protein intake 
below the level consumed by Americans (ADA Task Force 1987).

Cholesterol
Cholesterol consumption should be restricted to 300 mg/day or less to reduce cardiovascular
risk.

Calcium
High serum cholesterol levels have been observed in calcium-deficient lab animals. In 
humans, an uncontrolled study of 10 hyperlipidemic subjects showed that the addition of 
800 mg of calcium daily over 1 year reduced blood cholesterol levels by 25 percent. For 
diabetic people, calcium supplements may be necessary under special circumstances.

Potassium
The minimum RDA for potassium is approximately 1,600 to 2,000 mg per day. However, 
since there is considerable evidence that dietary potassium exerts a beneficial effect in 
hypertension, the National Research Council recommends that intake of fruits and 
vegetables be increased to raise potassium intake of adults to about 3,500 mg a day.

Sodium
Sodium should be restricted to 1,000 mg/1,000 kcal, not to exceed 3,000 mg/day, to 
minimize symptoms of hypertension.

Fiber
Recent studies have suggested that a higher intake of dietary fiber than is typical for 
Americans might improve many clinical conditions, including the abnormal glucose tolerance
of diabetes. Some studies have demonstrated that diets containing higher amounts of fiber 
(particularly water-soluble fiber) and carbohydrate are associated with lower blood glucose 
and serum lipid levels.
Very high-carbohydrate, high-fiber diets, providing 70 percent of calories as carbohydrate 
and 35 g of plant fiber per 1,000 calories, consistently improve glucose tolerance, decrease 
fasting plasma glucose levels, lower insulin needs, and decrease serum cholesterol 
concentrations. These results have been confirmed in longer term studies comparing a more
moderate diet that provides 55 to 60 percent of calories as carbohydrates and 25 g of plant 
fiber per 1,000 calories.

Alternative Sweeteners
Nutritive alternative sweeteners are sugars such as fructose and sorbitol that can be used as
sources of calories. Aspartame, strictly speaking, is a nutritive sweetener, but it is used in 
such small quantities that its caloric contribution is minimal. Non-nutritive alternative 
sweeteners, such as saccharin and cyclamate, provide virtually no calories in relation to 
their sweetness. Alternative sweeteners may be useful for persons with diabetes consuming 
sugar-restricted diets, both to provide sweetness without associated hyperglycemia and, in 
some cases, to help reduce caloric intake in overweight individuals.

See also How to Lose Weight

Important:    The dietary guidelines contained in this program are derived from research published by US 
government agencies and by private non-profit health organizations. The nutritional guidelines in this 
section are for your information only. Before adopting any diet, please obtain approval from your 
physician.





Dietary Guidelines for Lowering High Blood Pressure

Dietary Guidance from U.S. Surgeon General

Dietary factors that clearly contribute to high blood pressure include obesity and excessive 
intake of sodium and alcohol. The average daily sodium consumption of 4000 to 6000 mg by
adult Americans is substantially above the National Research Council's recommended range 
of 1100 mg to 3300 mg for safe and adequate intake and is 5 to 10 times higher than the 
amount required.

The strong association between obesity and hypertension and the demonstrated reduction 
in blood pressure that occurs with weight loss suggest that maintenance of desirable body 
weight should be a goal for the population.

Similarly, there is a direct association between blood pressure and alcohol consumption 
beyond about two standard-sized drinks daily.

Some evidence indicates that a reduction in blood pressure is associated with increased 
dietary intake of potassium, calcium, magnesium and fiber.

Achieving and maintaining desirable body weight and moderating sodium and alcohol intake
can lower blood pressure in patients with mild and moderate hypertension and reduce the 
need for antihypertensive medications. Such patients should be informed of the likely 
benefit of these dietary practices, along with the importance of adequate caloric expenditure
through exercise, and the moderation of fat intake to reduce high blood cholesterol levels 
and the risk for heart attack.



Food Exchange System

Starting with version 4.4, NutriGenie incorporates the ADA Food Exchange System into our software. The 
Food Exchange System was developed by the American Dietetic Association and the American Diabetes 
Association for people with diabetes and others on special diets to help them with meal planning. The 
system is based on sound nutrition principles and can be used by everyone, however. In particular, it can 
be used as a weight management alternative to calorie or fat gram counting.

The basic idea is that, within each food exchange category, you can choose among a variety of foods with
similar calorie and nutrient values. If you stay within your food exchange allowance, you are assured of a 
well-balanced diet that satisfies your calorie restriction.

Exchange Groups

1. Meat exchange:
Besides red meat, this exchange group includes fish, poultry, eggs, cheese, peanut butter and items that 
are high in protein. One meat exchange provides about 7 grams of protein. Most meat exchanges are 
based on one ounce of cooked meat.

One choice Calories Protein (g) Carbohydrate (g) Fat (g)
Non-fat 30 7 0 0
Low-fat 55 7 0 3
Medium-fat 75 7 0 5
High-fat 100 7 0 8

2. Bread / Starch exchange:
This exchange group includes cereals, grains, pastas, dried beans, starchy vegetables and breads. One 
exchange is equal to 1 ounce of bread or 1/2 cup of cereal or cooked pasta.

One choice Calories Protein (g) Carbohydrate (g) Fat (g)
80 3 15 trace

3. Vegetable exchange:
Vegetables are low-calorie and good sources of vitamins, minerals and fiber. One vegetable exchange is 
equal to 1/2 cup of cooked vegetables or 1 cup of raw vegetables.

One choice Calories Protein (g) Carbohydrate (g) Fat (g)
28 2 5 0

4. Fruit exchange:
Most fruit exchanges equal 1/2 cup fresh or canned fruit or fruit juice, or 1/4 cup dried fruit.

One choice Calories Protein (g) Carbohydrate (g) Fat (g)
60 0 15 0

5. Milk exchange:
Milk and milk products are excellent sources of calcium. If you are watching your weight, choose non-fat 
or low-fat milk products.

One choice Calories Protein (g) Carbohydrate (g) Fat (g)
Non-fat 80 8 12 0
Low-fat 107 8 12 3



Medium-fat 125 8 12 5
High-fat 150 8 12 8

6. Fat exchange:
A fat exchange is equal to 1 teaspoon of margarine or oil, or 1 tablespoon of salad dressing.

One choice Calories Protein (g) Carbohydrate (g) Fat (g)
45 0 0 5

7. Free exchange:

Foods in this group contain very few calories and can be used freely. They include salad greens, some 
vegetables and fruits, most condiments and beverages such as coffee, tea, mineral water.

Sample meal plans based on food exchanges

1,200 calories: 4 meat exchanges, 6 bread exchanges, 2 vegetable exchanges, 3 fruit exchanges, 2 milk 
exchanges and 2 fat exchanges.

1,500 calories: 5 meat exchanges, 8 bread exchanges, 3 vegetable exchanges, 4 fruit exchanges, 2 milk 
exchanges and 3 fat exchanges.

1,800 calories: 6 meat exchanges, 9 bread exchanges, 4 vegetable exchanges, 5 fruit exchanges, 2 milk 
exchanges and 4 fat exchanges.

See also
Using Food Exchanges with Automatic Menu Generator    



Using Food Exchanges with Automatic Menu Generator

To use Food Exchange System with NutriGenie Automatic Menu Generator, you need to use the 
Exchange Options dialog to specify the number of exchanges you wish to allocate for each meal. The 
dialog box will tally the exchanges you enter and give you an approximate caloric value of your diet.

Next, you need to assign your preferred foods to appropriate exchange and meal groups. The reason for 
this is that NutriGenie Exchange Menu Generator will use only the foods you want and only when 
you want them. For example, if you assign Scrambled Egg to the Meat Exchange and Breakfast groups, 
then Scrambled Egg will be considered a Meat Exchange option only at breakfast. It will not be selected 
as a Meat item at dinner or other meals. If you haven't assigned any food to an exchange or to a meal, 
NutriGenie will use items from a small list of common foods to satisfy your exchange requirements.

[The above 2 steps need to be done only once and can be refined as often as desired.]

Finally, click on this icon 
each time you want NutriGenie to generate a daily menu that meets your exchange requirements.

Note: 
When you assign food items to various exchanges, please make sure the item you assign is 
equivalent to 1 exchange in its group. 
For example, if 1 slice of your favorite bread is considered an exchange in the Bread group,    please 
assign this item (1 slice) to the Bread Exchange; do not assign a loaf of bread. 
Similarly, if 1 ounce of your favorite roast chicken is equivalent to a Meat exchange, you may need to 
create an entry for "Roast Chicken 1 oz" in your personal food database then assign this entry to the Meat
group and the desired Meal group(s).

Please refer to the exchange tables for approximation of nutrient contents of various exchanges. 

When NutriGenie generates your diet based on the USDA Food Guide Pyramid, the program 
automatically chooses the appropriate foods and calculates the right serving sizes for you. 
In contrast, to provide you with the most control over the menus generated, when NutriGenie suggests 
your daily meals based on the ADA Food Exchange System, you will specify the exact number of 
exchanges, the exact food items you want to use and their serving size per exchange. NutriGenie will use
other foods and calculate the required serving weight only when you haven't specified any selectable food
of your choice.
When generating menus, the software does check for basic validity of food items in various exchanges. 
For example, if you assign an item with no protein to the Meat exchange, or one without carbohydrate to 
the Fruit exchange, it will not be considered selectable.

The Fat exchanges you specify in the Exchange Options Dialog are only used to determine the 
approximate calorie level of your diet. No actual Fat items are generated for your menus. For this reason 
and the fact that food exchanges are often not uniquely determined by their caloric values, the menus 
generated by NutriGenie using your exchange requirements only approximate the total caloric values of 
your specified exchanges.



The K Factor

Population studies have shown that 
· higher dietary sodium intake correlates to higher blood pressure and 
· higher potassium intake corresponds to lower blood pressure.

Because sodium and especially potassium intakes have been shown to correlate more 
strongly than any other dietary factor to blood pressure, researchers have devised a concept
called the K Factor to help evaluate diet with regard to its beneficial effect on lowering high 
blood pressure.

The K Factor is simply the ratio of potassium to sodium (K is the chemical symbol for 
potassium). This value denotes the relative balance of potassium and sodium in your diet: a 
value higher than 3 (potassium intake more than 3 times that of sodium) may indicate a diet
beneficial to lowering blood pressure while a low value such as less than 1 may indicate the 
reverse.

NutriGenie automatically calculates the K Factor for your meal and your daily food intake. 
However, you can choose to display or not to display this value by toggling the 'Show K 
Factor' menu item.

A graphic symbol is associated with the K Factor:

    indicates a K Factor less than 2.

    indicates a K Factor from 2 to 2.5

    indicates a K Factor from 2.5 to 3.

    indicates a K Factor greater than 3.




